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M Glossary

A Introduction

Welcome to Windows 95 Concepts for Blind and Visually Impaired Users. This guide is a supplement to the standard user documentation and online help that is supplied with Windows 95. We offer it as a response to the specific needs of people who are visually impaired, especially those who are approaching the Windows 95 user interface for the first time. For such users, screen elements, processes, and procedures that seem obvious to a sighted user may require a fuller explanation.

This guide is designed to build an understanding of the Windows 95 user interface by offering a conceptual overview of the screen elements you encounter. Also, because most people who are visually impaired use the keyboard rather than the mouse, we offer a step-by-step guide to common keyboard procedures and shortcuts. Finally, interspersed throughout the guide are suggestions for customizing your system and easing your transition to the world of Windows 95.

In making this guide available, we hope to enable you to enjoy the full power and many advantages of the Windows 95 computing environment.

A 1 A Note on Keyboard Notation

In Windows 95, many keyboard operations use key combinations. These combinations consist of a control key (shift, alt, ctrl, or the Windows Logo key) and one or two other keys. In most cases, this combination of keys must be pressed at the same time, and the notation for that is the following: ctrl+esc.

The notation tab, down arrow or tab, then down arrow indicates that the two keys are to be pressed in succession. In some cases (such as selecting text or cycling through running programs using the Switch To command), the control key must be held down and another key must be pressed repeatedly while the first key is held down. This action is spelled out in the text where appropriate.

Two types of key combinations are used in the Windows 95 environment. These are:

Access keys: These special keystrokes are confined to the specific menu or dialog box that is currently active, and are specific to their particular program. They are indicated on the screen by an underlined character in the name of the menu or dialog box item. Access keys are noted in this guide in parentheses following the name of the command or the element, as in: Open the File menu (access key=F).

Shortcut keys: These special key combinations carry out commonly used commands or operations. There are three kinds of shortcut keys in Windows 95:



1. Program-specific shortcut keys

These key combinations are assigned by the currently running program. For example, the command ctrl+b, used in Microsoft Word to format the selected text as bold.



2. Windows 95 shortcut keys

These key combinations have the same effect throughout Windows 95. For example, ctrl+x, used in most Windows 95-based programs to cut the selected text and copy it to the Clipboard.

There are also shortcut key combinations that control the operation of Windows 95 as a whole, such as ctrl+esc, which opens the Start Menu from anywhere in Windows 95.



3. User-defined shortcut keys

These personalized key combinations are devised by the user to create shortcuts to commonly used files and programs, accessible from anywhere in Windows 95. See Section D 3.4.3 for information on how to do this.

B The Graphical User Interface (GUI)

Before Windows, access technology for the sight-impaired user was fairly simple. In the text-based MS-DOS operating system, the screen was made up of an array of rows and columns, and all information appeared in standard text characters and symbols (called ASCII characters). A screen-reader program simply intercepted the information delivered to the screen and presented it in a more accessible form–Braille or speech.

Windows uses an entirely different system for displaying data to the user–the Graphical User Interface (GUI). This system displays data on the screen in a graphic, or picture-based, form. The GUI has several advantages over the ASCII system: it can display a great deal of information simultaneously, it makes more intuitive sense to the average user, and it facilitates multi-tasking, or running more than one program at a time.

B 1 The GUI and Access Technology

The Graphical User Interface presents some challenges for screen-reader programs due to the way that information is transmitted to the screen. Instead of displaying ASCII characters with coded values, the GUI screen displays an array of thousands of tiny dots, called pixels. When a program sends data to the screen, the pixels combine to form an image—even if the data is simply a word. All information in a GUI interface is translated, or mapped, to a graphic or pictorial display. The screenreader cannot simply intercept the data transmitted to the screen, but must go behind the screen representation to access the information.

In addition, Windows can display information anywhere on the screen, in various sizes, and allows a user to shift back and forth between different layers of information (called windows). A screenreader must be able to identify where the system focus is at any moment (where the active work is being done) and ignore the other information present on the screen. In older text-based operating systems this was easy: the position of the insertion point would always indicate the part of the screen that was active. But Windows has many possible screen arrangements, and each can have multiple cursors with different shapes and actions, which makes tracking events on screen more difficult.

In order to present GUI program information in a non-visual way, screenreaders use a tool called an Off-Screen Model (or OSM). An OSM is a database of the information displayed on the screen. An OSM typically contains a list of all of the pieces of text that are on the screen, including the location, color, font, and size of each piece of text. OSMs also typically include information about each item that the user interacts with, such as buttons and icons. The screenreader then translates the contents of the OSM to the user in speech or Braille.

Today screen-reader programs for Windows 95 and Windows NT use several methods to interpret the screen for the OSM. The most common method is called a hook. A hook basically intercepts a display command as it is processed by the system. For example, if a program directs the system to display a button, the hook intercepts that command before the button is drawn on the screen and records the button’s location, size, and label in the OSM. Unfortunately, some programs create their own buttons or controls. In this case, it is difficult or impossible for the screenreader to intercept the drawing commands and record the relevant information in the OSM.

Microsoft is developing a technology called Active Accessibility that will greatly reduce the need for hooks. Active Accessibility allows accessibility utilities to communicate directly with programs to interpret what is on the screen. Office 97 already supports Active Accessibility for some custom controls, and future versions of Windows 95 and Windows NT will support Active Accessibility also. Accessibility utilities equipped with Active Accessibility will be introduced in mid-1997.

C Introducing Windows 95

Windows 95 is a total computing environment, designed to be both powerful and simple to use. It has many advantages over older operating systems, but it presents some challenges to sight-impaired users, particularly for those used to working in a DOS environment. However, with a little patience and willingness to learn a few new fundamental concepts, sight-impaired users will appreciate and benefit from Windows 95. The following sections give a brief overview of these basic concepts and discuss a few of the ways in which Windows 95 differs from previous versions of Windows, and from other operating systems.

C 1 The Visual Concepts Used in Windows 95

Windows 95 uses two central visual analogies for organizing and presenting data to the user.

C 1.1 The Desktop Analogy

The desktop is the guiding concept behind the Windows user interface. At a real desk, if you were writing a report, you would probably have several objects related to your task. You might have a typewriter, a dictionary, and various books and other documents close at hand. All of these objects would be arranged in an order that would allow you to complete your task quickly and efficiently. Similarly, the Windows desktop allows you to run many programs, such as the word processor, calendar, and calculator, at the same time, thus you can keep related information close at hand. For more information on the desktop, see Section D.

C 1.2 The Window Analogy

As its name suggests, Windows 95 uses windows to visually present data to the user. A window is a bordered square or rectangular area of the screen that contains controls and program, document, or system data. With windows, many different programs and documents can be displayed at once, in a way that makes intuitive sense to a user. Each program (such as a word processor, scheduler, or clock) that is open on the desktop appears in a different window. The borders of this window constitute the borders of the data.

An important thing to remember is that only one window can be active at once. That is, although many windows may be present on the screen, the system focus can only be given to one window at a time. One way to understand windows is to think of them as many different screens, each containing the data pertaining to one program or document. In Windows 95, these windows can be moved, overlapped, or closed altogether, just as you could arrange documents on your real desktop. A window can also be adjusted for size or reduced to a very small symbol on the screen, allowing for greater flexibility than is possible on a physical desktop. See Section F for more information about windows.

C 2 Standards and Similarity Between Programs

Most Windows programs tend to look and feel the same—they use the same types of controls, placed in similar locations. This general consistency is a great advantage to the user, both for learning new programs and using the programs he or she already has. For the sight-impaired user, this means that techniques learned once (keyboard techniques for bypassing the mouse, for instance) will not have to be learned again. Although not all commands or options are exactly the same, there is enough similarity that you shouldn’t have to search for basic commands every time you use a new program. This is especially true of Microsoft programs.

C 2.1 The Menu System

Microsoft’s design recommendations for Windows 95 specify that every program should include a line of high-level options called a menu bar. The menu bar runs along the top of the screen below the title bar, and usually contains between three and ten options, depending on the complexity of the program. The menu bar is accessed and navigated in the same way in every program. See Section E for more about menus.

C 2.2 The Method of Data Selection

Another similarity is the method of data selection. In most programs, data is selected by pressing shift while using the arrow keys to move the insertion point. Also, the key combinations for cutting, copying, and pasting data are the same for most programs.

C 3 Advantages of Windows 95 over Previous Versions

Windows 95 is an entirely new operating system, but it incorporates elements of all versions of Windows and MS-DOS that have preceded it.

C 3.1 Changes to the User Interface

Users of earlier versions of Windows will find some changes in the user interface. The Windows 95 desktop is simpler than that of previous versions, which makes it easier to start using your computer. Features like the Start button and the taskbar relieve the burden of memory on the user, and reduce the clutter on the screen. See Section D for more information about the desktop and its features.

C 3.2 Changes to the File System

Another change from Windows 3.1 is the system of file storage and management. Files in Windows 95 are stored in folders, which replace the old directories used in previous versions of Windows and in MS-DOS. The old MS-DOS limitation on the length of file names no longer applies. Also, the File Manager program found in Windows 3.1 has been replaced by a program called Windows Explorer. This program provides a simpler and more intuitive way of managing the files stored in your computer. See Section H 1.2 for more information on Windows Explorer.

C 3.3 Changes in Program Management

In earlier versions of Windows, when a program stopped, you had to restart the computer. Windows 95 contains a new feature called Task Manager, a program that allows you to close problematic programs without affecting other programs. See Section L 2 for more information about Task Manager.

C 3.4 Object Linking and Embedding

Windows 95 allows documents to share information by a process known as Object Linking and Embedding (OLE). Object Embedding is similar to cutting and pasting data across programs. Object Linking is the same as Object Embedding, except that the linked object remains in its original file, and any updates to the linked object appear in the target document as well. While this feature will not be discussed at length in this document, it is another powerful tool available in Windows 95.

C 3.5 Other Improvements

Windows 95 is now a 32-bit operating system (as compared with the 16-bit operating system of Windows 3.1). This means that it can move more data in less time; that is, it can do things faster. Built-in network and communications support provide easy access to the Internet, and to fax and e-mail programs. Plug and Play hardware support makes it much easier to install new components in your system.

Users of the MS-DOS operating system will find that MS-DOS-based programs are much better supported under Windows 95 than they were under Windows 3.1. This means that many MS-DOS-based programs which could not run in Windows 3.1 can now successfully run in Windows 95. Since Windows 95 makes maximum use of available memory for any program, some programs that were difficult to run in MS-DOS run even better in Windows 95. You can also run more than one MS-DOS session at a time (called multi-tasking). See Section K for more information on working with the Windows 95 DOS shell.

D The Windows 95 Desktop

When you first start Windows 95, you are presented with a fairly empty-looking screen. This is called the desktop. Like a physical desktop, this area serves as the surface where other work in windows will be done. For users of Windows 3.1, who are accustomed to Program Manager, this screen may seem unfamiliar. However, the desktop makes it easier for you to organize your work on your computer.

The desktop only contains a few features. On the left-hand side of the screen is a row of small symbols called icons. A bar called the taskbar runs along the bottom. On the far right-hand side of the taskbar is a clock. On the left-hand side of the taskbar is button with the word Start printed on it. This Start button replaces the Program Manager program in Windows 3.1.

The following sections describe these features in detail.

D 1 Icons and Toolbar Symbols

An icon is a small picture that Windows 95 uses to represent and create a link to a particular task, operation, file, or program. Icons are manipulated primarily with the mouse, but almost every operation can also be performed with a keyboard command. In some programs, icons can be moved around the screen, allowing a user to easily move or copy a file or folder from one place to another. In Windows Explorer, for example, dragging a file icon from one folder and dropping it into another folder on the same drive causes the actual file to be moved to that location. See Section J on using the Explorer program.
D 1.1 Identifying Icons and Toolbar Symbols

Most icons have their names printed in text below the graphic, which make them easy to identify and access with a screenreader. Toolbar symbols, however, lack this accompanying textual identification. Many programs feature visual toolbars which use toolbar symbols to perform a particular tool function. For instance, in Microsoft Word, a small picture of a printer can be clicked with the mouse to print the current document. Such a symbol can be difficult for screenreaders to identify.

Fortunately, these visual toolbars are only provided as shortcuts for mouse users, and they almost always refer to operations that can easily be performed using the keyboard and/or menus. Also, in Microsoft programs, and in most programs being developed for Windows 95, text labels called ToolTips are attached to such graphics, and may be viewed by moving the mouse cursor over the button. These ToolTips can be accessed by some screenreaders.

D 1.2 Selecting Versus Activating an Icon

There is a subtle but important difference between selecting an icon and activating it. Understanding this difference will eliminate potentially frustrating mistakes. When you select an icon, either with the mouse or by means of the arrow keys on the keyboard, you are moving the system focus to that icon so that any further operations will be performed on that icon. Activating an icon, on the other hand, is a further step that causes the file or program represented by that icon to open or start. For mouse users, an icon is selected with a single mouse click and activated with a double-click (two clicks in quick succession). For keyboard users, an icon is activated by pressing enter.

D 1.3 Types of Icons

There are two types of icons you can access from the keyboard in Windows 95.

D 1.3.1 File Icons and Program Icons

These icons represent individual data files (such as a word processing document) or programs (such as Calculator). File and program icons are found in programs like Explorer and My Computer. Each of these icons is accompanied by a text label, and is therefore accessible to a screenreader (see Section J on Windows Explorer and My Computer).

When you activate a file icon, that file opens within a particular program. When you activate an program icon, only the program starts.

D 1.3.2 Shortcut Icons

These icons provide shortcuts to your favorite programs or individual files. Shortcut icons are very small files—less than 1K—that contain pointers to the location of the actual program or file. Shortcuts allow you to access files or programs quickly and easily, eliminating the need to search your disk. Shortcut icons can be created, moved, renamed, or deleted without affecting the actual files or the organization of your hard disk. Shortcuts can be placed on the desktop (see Section D 4) and within folders such as the Start menu (see Section G 2).

D 1.4 Working with Shortcut Icons on the Desktop

Shortcut icons can be placed on the desktop, where they initially appear on the left-hand side. The graphic symbol on the icon varies according to the type of program or document the icon represents. Every shortcut icon also has a textual name, located immediately below the graphic. Shortcuts can be created, deleted, moved, and renamed (see the following sections). They may also be added to the Start menu (see Section G2).

D 1.4.1 To Select or List Shortcut Icons on the Desktop

There are two ways for keyboard users to select or list the items that are currently displayed on the desktop. The first is the easiest:

To select or list shortcut icons on the desktop using Windows Explorer



1) Open the program Windows Explorer from the Start menu.



2) In the Drives list, select Desktop.

This lists the items that are currently found on the desktop. As with any other file list, items can be selected, activated, moved, deleted, or copied using either the mouse or the keyboard. See Section J for more information about Windows Explorer.


Or,


To select or list shortcut icons on the desktop using the keyboard



1. Press ctrl+ESC to open the Start menu.



2. Press esc to close the Start menu, leaving the system focus on the Start button.



3. Press shift +tab to move the system focus to one of the icons on the desktop.

From there, you may use the arrow keys to move from icon to icon. The icon’s physical position on the desktop determines the order of selection.

These steps may be by-passed by assigning a shortcut key to the icon (see Section D 4.5).

D 1.4.2 To Rename a Shortcut Icon on the Desktop

You can rename an icon on the desktop to make it easier to work with and remember.


To rename a shortcut icon on the desktop



1. Select the icon.



2. Press F2.

This places a text insertion point at the beginning of the name. (see Section I 11 on working in edit fields).



3. When you are finished editing, press enter to save the new name.


Or,



1. Select the icon.



2. Press shift+F10 to open the icon context menu.



3. Select Rename (shortcut key = M).

This places a text insertion point at the beginning of the name.



4. Type in the new name and press enter to accept the changes.

D 1.4.3 To Delete a Shortcut Icon on the Desktop

You can delete a shortcut icon from the desktop using the keyboard. Remember that deleting a shortcut icon does not affect the file or program itself.


To delete a shortcut icon on the desktop



1. Select the icon.



2. Press Delete.

This opens a message box that asks if you really wish to send the item to the Recycle Bin.



3. Press enter to send the icon to the Recycle Bin.

See Section K for more information on the Recycle Bin.


Or,



1. Select the icon.



2. Press shift+F10 to open the icon context menu.



3. Select Delete (shortcut key = D). See Section E 8 for more about context menus.

D 1.4.4 To Create a Shortcut on the Desktop

Shortcut icons can be created on the desktop for any frequently used program or file.


To create a shortcut on the desktop



1. Locate the file using a file management program such as Find, Explorer, or My Computer. (see Section J for more information on these programs)



2. Select the file in the file list.



3. Press shift+F10 to open the context menu for that file.



4. In the context menu, select Create Shortcut (shortcut key = S).



5. Move the shortcut to the desktop. See Section E 8 for more about context menus.

D 1.4.5 To Assign a Shortcut Key to a Shortcut on the Desktop

You can quickly access commonly used programs and files by assigning shortcut keys to their icons on the desktop. Shortcut keys are special key combinations that allow you to perform an operation quickly and easily using the keyboard. For instance, you could create a shortcut icon for the command prompt on your desktop and assign it a shortcut key combination such as: ctrl+shift+D. Pressing this combination of keys would then open the command prompt from anywhere in Windows.

Shortcut key combinations must include the ctrl or alt key and at least one letter key. They may not contain the keys esc, enter, tab, spacebar, print screen, or backspace. The shift key and Function keys may be used. Key combinations that are already assigned to other operations in Windows 95 or are standard across many Windows programs (such as ctrl+V) also cannot be used.

WARNING

Once a shortcut key combination has been assigned, no other program may use that combination. If you use the combination ctrl+P, for instance, you would no longer be able to use that key combination to print the current document in Microsoft Word.

To assign a shortcut key to a shortcut icon on the desktop



1. Select the icon. (see Section D 4.1)



2. Press alt+enter to open the Properties dialog box for that icon.



3. Press ctrl+tab to move to the Shortcut section of the dialog box.



4. Press alt+K or press tab twice to move the selection to the Shortcut Key text box.

By default, this text box reads None.



5. Press the keys you wish to assign in the order you wish to assign them, following the rules for shortcut key combinations described in the preceding section.

The keys appear in the text box as you assign them. If you make a mistake while typing in the key combination, press the Backspace key and the text box will again read None.



6. When you have finished and are satisfied with the key combination you have assigned, press enter to accept the changes.

See Section I for more on dialog boxes and the Properties dialog box.
NOTE

Shortcut keys can only be assigned to shortcut icons on the desktop and in the Start menu. (see Section D 3)

D 2 The Taskbar

The taskbar is a long, narrow bar that runs along the bottom edge of your screen. It is always visible, no matter what else is on the screen. The taskbar simplifies program management by displaying all currently running programs. It also contains the Start button on its left-hand side (see Section D 3) and can contain the system clock and other useful status icons on the far right-hand side.

When you open a program, a button with that program’s name is added to the taskbar. Each new program adds another button, and after a certain number, the buttons are resized to fit the bar. The button for the active program appears pressed in.

When you minimize a program (see Section F 5.1), all windows associated with that program close, but the button remains on the taskbar. This means that the program is still running, but is inactive and is not accepting any keyboard input. This is different from closing a program, which removes the program from the computer’s active memory.

D 2.1 Using the Taskbar to Switch Between Running Programs

Mouse users can easily switch between running programs by clicking on the program buttons on the taskbar. Keyboard users can switch between running programs by using the following sequence of commands. This method is more involved than other methods such as the Switch To or Task Cycle commands. For information on these commands, see Section F 6.


To switch between running programs on the taskbar with the keyboard



1. Press ctrl+esc to open the Start menu.



2. Press esc to close the Start menu, leaving the system focus on the Start button.



3. Press tab to move the selection to the taskbar itself.



4. Press the left or right arrow keys to cycle through the buttons on the taskbar.



5. When you find the program you want, press enter or spacebar.

The program is now ready to receive keyboard input.

D 2.2 Repositioning the Taskbar

In some cases, the position of the taskbar on the bottom of the screen conflicts with other important information, such as that provided by your screenreader. You can resize or reposition the taskbar using direct manipulation from the keyboard.


To reposition the taskbar



1. Press ctrl+esc to open the Start menu.



2. Press esc to close the Start menu, leaving the system focus on the Start button.



3. Press alt+spacebar to open the taskbar context menu.



4. Select Move (shortcut = M).



5. Move the taskbar to its new position using the arrow cursor keys.



6. When you are satisfied with the new position, press enter.

See Section E 3 for more information about the context menu.

D 2.3 Resizing the Taskbar

The taskbar can be enlarged to facilitate button display.


To enlarge the taskbar



1. Press ctrl+esc to open the Start menu.



2. Press esc to close the Start menu, leaving the system focus on the Start button.



3. Press alt+spacebar to open the taskbar control menu.



4. Select Size (shortcut = S).



A blinking insertion point appears at to the border of the taskbar.



5. Press up arrow once to select the upper edge of the taskbar.



6. Press up arrow two more times to enlarge the taskbar.



7. Press enter to accept the changes.

D 2.4 The Taskbar Context Menu

The taskbar also has a context menu that contains options for adjusting the time and date, the window arrangement on the screen, and the taskbar’s properties.


To access the taskbar context menu



1. Press ctrl+esc to open the Start menu.



2. Press esc to close the Start menu, leaving the system focus on the Start button.



3. Press tab to select the taskbar



4. Press shift+F10 to open the context menu.

See Section E 4 for more about context menus.

D 3 The Start Button and the Start Menu

The Start button is the main access point for all programs and accessories on your system. Located on the lower left-hand corner of the desktop on the left side of the taskbar, the Start button is really just a switch to open a menu—the Start menu. Because the Start menu is tucked inside the Start button when it is not in use, it remains available yet out of the way, allowing you easy and immediate access to your programs and settings from anywhere in Windows.

D 3.1 Activating the Start Button from the Keyboard

Pressing the key combination ctrl+esc activates the Start button and opens the Start menu from any place in Windows 95. If you wish to select the Start button, without activating it (for instance, to change its position on the screen), press esc a second time. This closes the Start menu but leaves the focus on the Start button. This is also one way to access the taskbar (see Section D 2 for more information about the taskbar).

D 3.2 The Start Menu

The Start menu is a pop-up menu that appears to the right of the Start button. It consists of a vertical list of commands`which may be scrolled through and selected one at a time (see Section E for more about menus). By default, there are seven commands on the Start menu: Programs, Documents, Settings, Find, Help, Run, and Shut Down. These are each described in detail in Section D 3.3.

D 3.2.1 Navigating the Start Menu

Press ctrl+esc to bring up the Start menu, then use the up and down arrow keys to select a particular command. Some of the commands on the Start menu, such as, Programs, Documents, Settings, and Find, lead to further lists of commands (called submenus). Press enter or the right arrow key to open the submenus for these commands.

Note

Commands on the Start menu are sometimes referred to as folders.

D 3.2.1.1 Shortcut Keys for the Start Menu

All seven commands on the initial Start menu have shortcut keys. For all of the commands except the last, these keys are the first letter of the command name (p for Program, d for Documents, and so on). For the last command, Shutdown, the shortcut key is u. Pressing the shortcut key for a command after pressing ctrl+esc immediately activates the command, saving several keystrokes. For example, to activate the Programs submenu, press ctrl+esc, then press p. See Section D 3.4 for more about shortcut keys.

D 3.2.1.2 Closing the Start Menu

To close the Start menu entirely, press alt. As with all menus, you can close each level of menu activation successively using the esc key. Closing the Start menu either of these ways leaves the system focus on the Start button.

To get back to your running program:



1. Use the arrow keys to move the focus on the taskbar to the program button that you want. Then press enter or spacebar to switch to that program. This method is described in more detail in Section D 2.



2. Use the Switch To command (alt+tab) to quickly switch between running programs. See Section F 4.2.1 for details on the Switch To command.



3. You can also use the Task Cycle command (alt+esc) to quickly switch between windows displayed on the desktop. See Section F 4.2.2 for information on the Task Cycle command.

D 3.3 The Seven Default Commands on the Start Menu

Initially, there are seven commands on the Start menu: Programs (shortcut key = p), Documents (shortcut key = d), Settings (shortcut key = s), Find (shortcut key = f), Help (shortcut key = h), Run (shortcut key = r), and Shut Down (shortcut key = u). These commands are described in the following sections.

You can also add commands to your Start menu to quickly access frequently used files, programs, or folders. This process is described in detail in Section D 3.4.

D 3.3.1 The Programs Command on the Start Menu

The Programs command on the Start menu replaces the Program Manager application in Windows 3.1, and is the main route to your programs. When you activate this command, a submenu opens to the right of the command name. This menu contains an alphabetical list of the programs installed in your system. Use the up and down arrow keys or press the initial letter of the program you want. When you find the program you want, press enter to start it.

Note

If you installed Windows 95 into your old Windows 3.1 directory, the Programs folder should contain all your existing Windows 3.1 program groups. These were automatically converted when Windows 95 was installed. Otherwise, if you installed Windows 95 into a separate directory, your Windows 3.1 program groups may not appear on your new Programs directory.

To remedy this, you can run a special program (Run: grpconv/m). This converts Program Manager groups into folders on the Windows 95 Programs menu. If your programs still do not work after running this program, you may need to re-install these programs from within Windows 95.

D 3.3.2 The Documents Command on the Start Menu

Activating the Documents command on the Start menu (shortcut key = d) opens a submenu listing your most recently opened files. This is a useful way to quickly access your current projects. Activating a file from this list automatically opens the file and starts the program it belongs to. By default, the number of files listed on the Documents menu is fifteen.

D 3.3.3 The Settings Command on the Start Menu

The Settings command on the Start menu (shortcut key = s) displays a list of system components with settings options. The three default items on this list are Control Panel, Printers and Taskbar. The Control Panel includes features which are useful for users with visual impairments in the Accessibility Options, Display, Keyboard, and Mouse sections. (See Section H 2)

D 3.3.4 The Find Command on the Start Menu

The Find command on the Start menu (shortcut key = f) opens a powerful search program for finding files on your computer or your network using a variety of search options. When you select the Find command, a submenu appears. The first item on this menu is Files and Folders (shortcut key = f). Selecting this option opens a dialog box asking you for information about your search (see Section G for more about dialog boxes). The second item on the Find menu is Computer (shortcut key = c). This option allows you to search for other computers on your network.

D 3.3.5 The Help Command on the Start Menu

The Help command on the Start menu (shortcut key = h) is a shortcut to Windows Help. You can also access Help from the desktop by pressing f1, but remember that pressing f1 while working in an program may bring up the program Help system, rather than that of Windows 95. See Section J on the Windows 95 Help system.

D 3.3.6 The Run Command on the Start Menu

The Run command on the Start menu (shortcut key = r) allows you to run a named program. Activating this command opens a dialog box with a text box asking for the path and file name of the program you want to run. Type in the path and press enter to start the program. (see Section G 3.4 for more about text boxes.) There is also a browse function, which displays a list of your files in a particular folder. To access this function, tab to the Browse button in the dialog box and press enter. See Section G for more about dialog boxes.

D 3.3.7 The Shut Down Command on the Start Menu

The Shut Down command on the Start menu (shortcut key = u) provides the safe and correct way to end all running programs and shut down your computer. This is the command you should choose whenever you end a Windows 95 session. Windows 95 and programs designed for Windows 95 create temporary files while the programs are running, and the data in these files needs to be properly handled. Even in cases of a program stop or freeze, it is usually possible to close the offending program and shut down Windows in the safe way. See Section C3.3 for more about closing programs that have stopped.

Selecting the Shut Down command opens a dialog box that contains four options:



1. Shut down the computer



2. Restart the computer



3. Restart the computer in MS-DOS mode (see Section K1)


4. Close all programs and log on as a different user (a network option)

To select an option, use the up or down arrow keys to cycle through the buttons to the option you desire. When you have selected your option, press y for Yes, or press enter. To close the dialog box without activating any of the options, press n for No. See Section G for more about working in dialog boxes.

D 3.4 Customizing the Start Menu

In addition to the seven initial commands on the Start menu, it is possible to add items of your own. Shortcuts to commonly used files and programs, discussed earlier in the section on the desktop (Section D1.4), can be added to the Start menu. For keyboard users, shortcut items added to the Start menu are even more useful than shortcuts on the desktop, since the Start menu can be accessed from anywhere in Windows with a few simple keystrokes.

D 3.4.1 Adding a Shortcut to the Start Menu


To add a shortcut to the Start menu



1. Press ctrl+esc to open the Start menu.



2. Select Settings (shortcut = s).

A submenu opens.



3. Select Taskbar.

The Taskbar Properties dialog box opens. (You can also access this dialog more directly from the taskbar shortcut menu. See Section D 2.4 for details.)



4. In Taskbar Properties, press the tab key to move to the Start Menu Programs tab.



5. Select Add and press enter.

You will be prompted to enter the file name and path of the file you wish to add. (If you don’t know, you can use the Browse button to find it. See Section D 3.3.6 for more about the Browse button.)



7. Press enter.



8. You will be asked where you would like to put the new shortcut: in an existing folder or a new one. Selecting New creates a new command on the initial Start menu. Selecting an existing folder causes the new shortcut to appear as a command on a submenu.

D 3.4.2 Removing a Shortcut from the Start Menu


To remove a shortcut from the Start menu



1. Follow the procedure for opening the Taskbar Properties dialog box, in the preceding section.



2. In Taskbar Properties, press the tab key to move to the Start Menu Programs tab.



3. Select Remove and press enter.

You will be prompted to enter the file name and path of the file you wish to remove. (If you don’t know, you can use the Browse button to find it. See Section D 3.3.6 for more about the Browse button.)

See Section G for more information about working in dialog boxes. For information about placing shortcuts on the desktop, see Section D 1.4. For information about placing shortcuts in other locations, see Section H 1.5.1.

D 3.4.3 Assigning a Shortcut Key to a Shortcut on the Start Menu

As with icons on the desktop, you can assign shortcut keys to any shortcut you create on the Start menu. Shortcut keys are special key combinations that allow you to perform an operation quickly and easily using the keyboard, bypassing the use of menus. For instance, if you have created a shortcut command for Microsoft Word on your Start menu, you could assign it the shortcut keys ctrl+shift+m. Pressing this combination of keys would then start Word from anywhere in Windows.

The rules and procedures for assigning shortcut keys are exactly the same for both the Start menu and the desktop (see Section D 1.4).



To assign a shortcut key to a shortcut on the Start menu



1. Locate the item on the Start menu, or add it if you have not already done so (see Section D 3.4.1).



2. Select the item without activating it.



3. Press alt+enter to open the Properties dialog box for that icon.



4. Press ctrl+tab to move to the Shortcut section of the dialog box.



5. Press alt+k or press the tab key twice to move the selection to the Shortcut Key text box. By default, this text box reads None.



6. Press the keys you wish to assign in the order you wish to assign them, following the rules for shortcut key combinations described in Section D 1.4.

The keys appear in the text box as you assign them. If you make a mistake while typing in the key combination, press the backspace key and the text box again reads None.



7. When you have finished and are satisfied with the key combination you have assigned, press enter to accept the changes.

See Section I for more on dialog boxes and the Properties dialog box.
Note

Shortcut keys can only be assigned to shortcut icons on the desktop and to shortcuts in the Start menu (see Section D 3).

E Menus

Like a menu in a restaurant, a menu in the Windows 95 environment presents you with a list of items to choose from, using either the keyboard or the mouse. Windows 95 and most Windows programs use a variety of menu types, described in the following sections.

E 1 The Menu Bar

In Windows programs, the highest-level command options appear in a menu bar, which is a horizontal list of commands printed in a box across the top of the program window, below the title bar. These high-level command options vary slightly from program to program, but are designed to be fairly standard in terms of type and order of options. In most cases, the first option on the list is the control menu, which is represented by an icon rather than text. In Microsoft Word, for instance, the remaining menu bar options are File, Edit, View, Insert, Format, Tools, Table, Window, and Help.

E 1.1 Selecting Options from the Menu Bar

The menu bar itself can always be accessed from the keyboard by pressing alt or f10. This shifts the system focus to the menu bar and selects the first menu bar item, which is the item to the farthest left of the list. In most cases, this first item is the control menu icon for the current document, but it might also be the control menu icon for the program if the program has no open document windows (see Section E 7 on control menus).

After the menu bar is activated, use the left or right arrow keys to cycle through the menu bar options. The up or down arrow keys or the enter key activates the drop-down menu for the selected menu bar item (see Section E 2).

As each menu bar option is selected, a brief description of the item and its function usually appears in the status bar at the bottom of the screen. In some cases, this information is accessible to your screenreader. See Section F 3.5 for more about the status bar.

E 1.2 Shortcut Keys for Commands on the Menu Bar

Options on the menu bar and in drop-down menus have shortcut keys assigned to them. To choose a command quickly from the keyboard, press the alt key to activate the menu bar, followed by the shortcut key for the menu option desired. These shortcut keys are indicated visually on the menu bar by an underscore beneath the shortcut character in the option’s name. Where it does not conflict with another shortcut, this character is usually the first letter in the word. For example, alt+h opens a program’s Help menu. Commands in drop-down menus also have shortcut keys (see Section E 2.2).

In addition, in most programs some commands can be activated directly using special key combinations called shortcut keys. For instance, in most programs alt+f4 closes the program, bypassing the need to access the file menu entirely.

E 2 Drop-down Menus

Most options on a program menu bar open other menus. These drop-down menus appear on the screen in a vertical list surrounded by a box, directly below the menu bar option you have selected. For example, choosing File on the menu bar opens a drop-down menu containing the commands: New, Open, Save, Print, and Exit.

E 2.1 Navigating in Drop-down Menus

By default, when a drop-down menu is opened the first (top) item on the list is selected. Other commands can be selected and scrolled through using the up or down arrow keys. A selected command can be activated by pressing enter. You can also activate a command by using shortcut keys (see the following section).

To cancel a drop-down menu but stay in the menu bar, press esc. Press the left or right arrow keys while a drop-down menu is open to scroll from menu to menu along the menu bar. To leave the menu system and return to a program or document window, press alt.

E 2.2 Shortcut Keys in Drop-down Menus

Many commands in drop-down menus are assigned shortcut keys, which allow you to press a single key to activate the command. The shortcut key for a command is the underlined character in its name. Usually this is the first letter, unless it conflicts with a shortcut key that has been previously assigned.

Once you become familiar with shortcut keys for a given program, it is possible to use them in combination, in effect bypassing the menu system altogether. For example, in Microsoft Word, if you are in a document window and wish to save a file quickly, you can press the keys alt+f+s in succession. The alt character accesses the menu bar, the f key opens the File menu, and the s key is the shortcut for the Save command.

Note

You can also use the alt key to switch the focus between the active document and the menu system and back again.

E 2.3 The Three Kinds of Drop-down Menu Commands

Activating a command on a drop-down menu results in one of three things:



1. A command is carried out (for example, if you activate Exit, you will exit the document).



2. A dialog box opens, requesting information or confirmation. This is indicated by three dots following the menu command (such as, Save...). See Section I for more about dialog boxes.



3. A further drop-down menu appears to the side of the item. These menus, called submenus, are indicated by an arrow following the menu command name (see E 2.6).

E 2.4 Toggle Switches in Drop-down Menus

Some commands on drop-down menus are toggle switches that merely change the status of the program environment in some way. Toggle switches have two states: off and on. This is indicated by the presence or absence of a check mark next to the command’s name in the menu list. A check mark means the command is turned on. For example, in the View menu of Windows Explorer there are two commands called Toolbar and Status Bar. These commands allow you to control the elements displayed on your screen. If there is a check mark next to Toolbar, the toolbar is visible on the screen. To remove the toolbar display, activate the command. This also removes the check mark. To display the toolbar again, simply activate the command.

E 2.5 Unavailable Menu Items

Sometimes commands in drop-down menus are not available at a certain time. In an Edit menu, for instance, the Paste command cannot be used if there is nothing in the clipboard. These unavailable items are represented visually in the menu by gray type; they may be selected with the keyboard but not activated. When a command is available (for example, when text is in the clipboard), the typeface appears black.

E 2.6 Submenus

Menus that are invoked from drop-down menus are known as submenus. Their presence is indicated by a right-pointing arrowhead character next to the name of the parent menu command. When such a command is activated, the new menu appears immediately to the right of the command (if there is no more room on the screen, the menu is displayed to the left of the item).

Submenus look and behave just like drop-down menus–they display a vertical list of commands, and the process of selecting and activating the commands is the same (see the earlier sections on drop-down menus). To close a submenu and return to the parent menu, press esc or the left arrow key. To close all menus, press alt.

E 3 The Control Menu

Most windows in the Windows 95 environment have a control menu, which is a drop-down menu with commands to control the window’s size and position on the screen.

The control menu of the program window is sometimes called the program menu, and appears as an icon in the far upper left corner of the program window. The control menu of the document window, if a document is open, is directly below this, at the far left of the menu bar. (See Section F, Types and Features of Windows, for more information about program and document windows.)

Both of these control menus are part of the menu bar for the program. To access the control menu for the program, press alt+space.  To access the control menu for the document, press alt+hyphen. 

E 3.1 Selecting Commands from the Control Menu

The control menu operates like any other drop-down menu, and can be accessed with shortcut keys (see Section E 2 for more about drop-down menus). Commands on the control menu usually include: Restore (shortcut key = r), Size (shortcut key = s), Move (shortcut key = m), Minimize (shortcut key = n), Maximize (shortcut key = x), and Close (shortcut key = c). See Section F for more information about working with program and document windows.

E 4 Context Menus

Many objects in Windows 95 have a special menu attached to them to allow a user to do common tasks related to that object. This menu is called a context menu, but is also referred to as a shortcut menu. Context menus are pop-up menus, so named because they pop up on the screen immediately next to the object they belong to. Like drop-down menus, pop-up menus display their commands in a vertical list. Once they are open, the process of navigating and selecting items is the same as that for drop-down menus (see Section E 2).

To access the context menu for an object, make sure the object is selected, then press shift+F10.

The commands on context menus vary widely, depending upon the type of object the menu belongs to. For instance, the context menu for a file icon contains the commands: Open, Send, Delete, and Properties. The context menu for the taskbar contains commands for arranging the screen: Cascade, Tiling, and Properties.

E 4.1 Selecting Commands from a Context Menu

Context menus operate like any other pop-up menu. Commands may or may not have shortcut keys assigned to them (indicated by an underlined letter). Or you can use the up or down arrow keys and enter to select and activate a command. To deactivate the menu without selecting a command, press esc.

F Working with Program and Document Windows

The Windows 95 environment may be confusing for the sight-impaired user initially, due to the nature of the window. Windows can be opened or closed anywhere on the screen, moved around at will, displayed off the edge of the screen or obscured entirely by other windows.

These features are designed to render Windows 95 more intuitive to the average user. The actual program functioning, however, is not as complex as it might appear. With a little understanding of the basic concepts, and mastery of a few simple keyboard techniques, you can navigate easily and quickly in the Windows environment.

F 1 The Concept of the Window

The window is the main tool that Windows 95 uses to organize and present data to the user on the screen. Essentially, a window is a square or rectangular area on the screen that displays the information related to a specific task or program. Like an actual window, a window presents a view bounded by a frame. Every program that you run appears in its own window on the desktop; multiple programs result in multiple windows on the screen.

In Windows 95, windows appear and behave as though they were three-dimensional. Thus it might be useful to think of an individual window as something between a window and a piece of paper—like a window, it offers a view through its frame at the information it contains. Like a piece of paper, it can be stacked with other windows, shuffled, moved around, and otherwise manipulated on the screen. Also like a piece of paper (and unlike an actual window), windows on the screen are represented as opaque. That is, when windows overlap each other, only the data in the top window can be seen. The bottom window appears to pass out of sight below the overlapping window, perhaps remaining visible only along one of its edges.

All of this is designed with the desktop metaphor in mind, to make Windows 95 intuitive for the average user. However, it’s not necessary to organize the screen in such a manner. For a visually impaired user, for instance, there may be no advantage to arranging windows in overlapping stacks. Instead, you might wish to open all windows in their full-screen (maximized) mode, and switch from window to window using one of the techniques discussed in Section F 4. Alternatively, you might wish to arrange all windows on the screen in orderly, non-overlapped rows and columns (called tiling). See Section F 4.1 for more about arranging multiple windows on the screen.

Importantly, only one program window may be active at any given time. That is, no matter how cluttered the screen, only one window is ever available to accept input from the keyboard. In the three-dimensional visual analogy of the Windows screen, the active window always appears to be on top (that is, in front of) any other windows that it overlaps. Thus, the entire border and all of the workspace of the active window is always visible (and available to a screenreader).

F 2 The Types of Windows

Windows 95 uses three main types of windows:



1. Program windows



2. Document windows



3. Other specialized windows, such as, dialog boxes (for interactive tasks) and message boxes (for messages and warnings)

Program and document windows are described in the following sections. See Section G for information about dialog boxes.

F 2.1 Program Windows

Program windows contain all the data, menus, toolbars, and other features associated with a particular program. They may also contain one or more document windows. Each program you start appears in a different program window, and it is possible to have many such windows present on the screen. There are three ways to move between program windows using the keyboard. These are discussed in Section F 4.2. For information about navigating within a program window (see Section F 4.3).

Typically, a program window in Windows 95 consists of a frame, a title bar across the top displaying the name of the program, a menu bar directly below the title bar, and a workspace that occupies the majority of the window. These elements are discussed in Section F 3, Components of a Window. A program window also contains a control menu, accessed by a control menu icon in the upper left-hand corner of the screen. The control menu manipulates the size and position of the window. See Section E 3 for more about the control menu.

The workspace is the main area where document files and other data are displayed. In some programs (such as Explorer), the workspace is divided into one or more smaller frames or panes that are designed to hold different kinds of information. In some simple programs, such as Notepad, data files open directly into the workspace and there are no document windows. In most programs, the workspace contains one or more document windows.

F 2.2 Document Windows

Program windows usually (but not always) present their data in other windows called document windows. Document windows are dependent upon program windows. That is, they can only exist inside of the window of the program that has created them. This dependency has three effects:



1. A document window can only appear within the boundaries of its program window on the screen.



2. When the program window moves, the document window moves too.



3. Document windows do not have menu bars.

Like a program window, a document window has a frame, a workspace, and controls for navigating in the window and for changing the window’s size and position. A document window does not have a menu bar nor a status bar.

Document windows have their own title bars unless they are maximized. When maximized, document windows fill the program workspace and share the program window’s title bar. In this case, the name of the document is included with the name of the program on the program window’s title bar, and the control menu for the document window is added to the far left of the program window’s menu bar. See Section F 3 for more information about these window components.

Some programs allow you to open more than one document window, but always within the boundaries of the program window. In such a case, only one of these document windows can be active at a time. Like program windows, document windows can tile or overlap. See Section F 4.3 for information about navigating between multiple document windows within a program.

F 3 Components of a Window

Both program and document windows have the following components:

· a frame

· a title bar

· a control menu icon and control menu.

In addition, program windows have:

· a menu bar

· a status bar.

These components are discussed in the following sections.

F 3.1 The Frame

The frame is a square or rectangular border that defines the edges of a window, marking the boundary of the window’s workspace. It is usually a line or a band of a darker color that is distinct from both the background color of the desktop and the color of the workspace inside the frame. The size of the frame (and thus the size of the window) can usually be changed, although in some windows (such as dialog boxes) the frame cannot be resized.

F 3.2 The Title Bar

In most windows, the top horizontal edge of the frame is called the title bar. This is a somewhat wider band that contains the title of the window. By default, the title bar is gray in color when the window is inactive. When the window is activated, the title bar turns blue.

In most programs, the title bar of a program window contains the program name, such as Microsoft Excel. If you have opened a file, the title bar of the document window contains the name of this open file. If you have maximized the document window to fill the entire workspace of the program window, the document window’s title bar typically disappears, and the title bar of the program window changes to display both the program title and the name of the file (for example, Microsoft Excel - EXPENSES.XLS).

In most cases, the title bar also contains three controls on its right-hand side: the Minimize button (a box with a horizontal bar on its bottom edge), the Maximize button (a box with a square), and the Close button (a box with an X). These buttons allow mouse users to control the size of the window. They are shortcuts to commands in the control menu, which can also be carried out through the keyboard. See Section F 3.3 and Section E 3 for more about the control menu.

F 3.3 The Control Menu Icon and the Control Menu

Program and document windows feature a control menu, which contains commands for changing the size and position of the window. This control menu opens under the control menu icon, a small symbol in the upper left-hand corner of the window, on the left-hand side of the title bar. The actual graphic used for this icon varies from program to program (in Microsoft Word, for instance, the symbol is a w). Clicking on this icon with the mouse, or activating it from the keyboard, opens a drop-down menu directly under the icon. See Section E 3 for more about control menu commands.

The control menu for a program window can be accessed directly from the keyboard using the key combination alt+spacebar. The control menu for a document window can be accessed using the key combination alt+hyphen.

See Section E 31 for more information about using the keyboard to navigate in the control menu.

F 3.4 The Menu Bar of a Program Window

The menu bar is located at the top of the program window, directly below the title bar. It consists of a horizontal list of high-level command options for controlling the program and its files. The menu bar can be accessed from the keyboard with the alt key or f10, or its individual options can be activated by shortcut keys. The menu bar is described in detail in Section E 1.

F 3.5 The Status Bar of a Program Window

The status bar is a bar at the bottom of the program window that displays helpful information relevant to the status of the program. Not all programs feature status bars, and those that do may display different information, depending upon the type of program. In Microsoft Word, for instance, the status bar includes fields that indicate the current position of the insertion point in the document and the current page number. The status bar often contains shortcuts for mouse users. These shortcuts can be carried out through the keyboard and menu system.

Unfortunately, since the status bar is not directly accessible from the keyboard except by means of MouseKeys (see Section I 6.1), screenreaders may not identify it.

F 4 Navigating Between Windows Using the Keyboard

One of the most powerful features of Windows 95 is its ability to support multi-tasking, or running more than one program at a time. The following section discusses concrete ways for the sight-impaired user to take advantage of this feature.

F 4.1 Arranging Multiple Windows on the Screen

You can arrange multiple open windows many different ways on the screen. Windows may be cascaded, or arranged in overlapping stacks like sheets of paper. Mouse users often prefer this method. Alternatively, windows may be tiled, or arranged in non-overlapping rows and columns of equal size. This method has the advantage of displaying the contents of every open window on the screen at the same time.

You may also choose to work with all windows minimized, or reduced to buttons on the taskbar, except for the window you are currently working on. Or you may choose to work with all windows maximized, and move between the windows as you need them using the Switch To or Task Cycle commands (see Section F 4.2 for more about these commands).

The commands in the taskbar’s context menu control the display of all open windows on the desktop.


To change the presentation of all open windows on the screen



1. Press ctrl+esc to open the Start menu.



2. Press esc again to close the Start menu, leaving the focus on the Start button.



3. Press tab to access the taskbar.



4. Press shift+f10 to open the taskbar’s context menu.

A pop-up menu opens, with the following commands:
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5. Select the command you want and press enter.

If your keyboard has a Windows logo key (located in the lower left between the ctrl and the alt keys), you can also minimize all open windows by pressing the key combination Windows logo key+m.

F 4.2 Switching Between Running Programs

There are three ways to switch between the program windows of running programs using the keyboard: the Switch To command, the Task Cycle command, and the taskbar method. These three ways are described in the following sections.

F 4.2.1 The Switch To Command

The Switch To command (alt+tab) is a fast way to switch between your currently running programs, because it allows you to scroll through the titles of your programs instead of the programs themselves. This saves time, especially if you are using a screenreader. When you select a minimized program using the Switch To command, the program’s window automatically opens to its previous position on the screen, ready for you to work in it.

To change windows using the Switch To command



1. Press alt+tab to activate the Switch To command display from anywhere in Windows 95.

A message window appears in the center of the screen, with the names of your active programs.



2. Release the tab key while continuing to hold the alt key down.

The message box remains open.



3. Press tab repeatedly to move the selection from option to option.



4. When you have selected the program you want, release both the tab and the alt keys.

The program window for the selected program is activated. If it was minimized, it is restored to its original screen position.

F 4.2.2 The Task Cycle Command

The Task Cycle command (alt+esc) switches the system focus to each running program in turn. If you are using a screenreader, this can be slow, since the screenreader will try to process all the information in each of the windows as you cycle through them. If a window is minimized, the Task Cycle command shifts the system focus to the minimized button for the program on the taskbar, requiring you to take additional steps to restore or maximize the window (see Section E 3) if you want to use it.

For these reasons, you will probably prefer to use the Switch To command (alt+tab) most of the time. However, the Task Cycle command does have one advantage: it allows you to access windows which do not have taskbar buttons, such as dialog boxes (see Section G). The Switch To command does not provide this capability.

To switch program windows using the Task Cycle command

Press alt+esc repeatedly until the desired program is activated.
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Press alt+shift+esc to cycle through the programs in reverse order.
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If your program is minimized, you can maximize it by pressing enter.

F 4.2.3 The Program Buttons on the Taskbar

You can also select and restore running programs on the taskbar. If you are using the keyboard, this process is somewhat more involved than the Switch To command. See Section D 2 for more about the taskbar.


To switch between running programs on the taskbar



1. Press ctrl+esc to open the Start menu.



2. Press esc again to close the Start menu, leaving the focus on the Start button.



3. Press tab to move the selection to the first program button on the taskbar.



4. From here, use the left or right arrow keys to cycle through the buttons on the taskbar.



5. When you find the program you want, press enter or spacebar.

The program opens, ready to receive keyboard input.

F 4.3 Switching Between Document Windows Within a Program

The easiest way to move from window to window within a program is through the program’s menu bar. In most programs, the Window menu (shortcut=w), located on the menu bar, contains the relevant commands. Typically, all open document windows are assigned a number in the order in which they are opened, and each window appears as an option in the Window menu, with the number of the window and the window title listed on the option line. The window number acts as the shortcut key for that window. Thus, to switch to the first open window, press alt+w+1. This accesses the menu system, selects the drop-down Window menu, and selects document window number one.

The shortcut key combination ctrl+f6 (sometimes ctrl+tab) can also be used to switch to a new document window in the currently active program. This command operates like the Task Cycle command: it switches the system focus to the next document window. If you have many document windows open and are using a screenreader, this method may be slow. In such a case, you may wish to use the menu bar method described earlier.

A few other commands for controlling document windows work in most Windows 95 programs:
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The shortcut key combination ctrl+f4 closes the active document window in most programs.
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alt+hyphen opens the control menu for the current document window. (See Section K 3.1 for more about control menus).
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The Arrange All command, located on the drop-down Window menu on the menu bar of most Windows 95 programs, is the equivalent of the Tile command for multiple document windows. That is, it arranges all open windows in orderly, non-overlapping rows and columns in the program workspace.

F 5 Navigating Within a Window

Navigating within a window is similar to reading a Braille page through a small hole in a piece of cardboard. To read more of the page, you could do one of three things: you could make the hole larger, you could make the document smaller, or you could move the document behind the hole. Similarly, in order to access all of the information in a document window, you can do one of three things: enlarge the window frame, shrink the document, or move the document beneath the frame. The following sections describe techniques for doing these three things.

F 5.1 Changing the Size of a Window Frame

The control menu contains commands for changing a window’s size. You can access the control menu for the current document through the program menu bar, or with the shortcut key combination alt+hyphen. Typically, this menu contains the commands Restore, Move, Size, Minimize, and Maximize. See Section K 3.1 for more about the control menu.

F 5.1.1 Maximizing a Window

To maximize a window is to make the frame as big as the screen allows. When a program window is maximized, none of the desktop is visible except the taskbar, which by default remains visible at all times. When a document window is maximized, it fills the workspace of its program window entirely. Note that a document window must always stay within the borders of its program window; in order to maximize a document window to its fullest extent, the window of its parent program must already be maximized.

You can use the keyboard to maximize program and document windows through their control menus (see Section E 3).

F 5.1.2 Resizing a Window

The size and shape of a window can be changed within its maximized limit.


To change the size of a window



1. Open the window’s control menu (alt+hyphen for a document, alt+spacebar for a program).



2. Select Size (shortcut key = s).



3. Press the arrow keys to select one edge of the window frame.



4. Press the arrow keys to move that edge in the desired direction.



5. Press enter to fix that edge in its new location.



6. Repeat if necessary with other edges of the window.

F 5.1.3 Minimizing a Window

You can minimize a window through the program control menu (as described in the preceding section) or through the taskbar. In a program window, minimizing reduces the window to a small button on the taskbar. In a document window, minimizing reduces the window to an icon in the program’s workspace.

There may be times when you wish to work with an empty desktop. You can do so quickly using the following procedure.


To minimize all open windows on the screen



1. Press ctrl+esc to open the Start menu.



2. Press esc again to close the Start menu, leaving the focus on the Start button.



3. Press tab to access the taskbar.



4. Press alt+m, or press shift+f10 to open the taskbar’s context menu.

A pop-up menu opens, with the following commands, among others:
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5. Select Minimize All (shortcut = m) and press enter.

If your keyboard has a Windows logo key (located in the lower left between the ctrl and the alt keys), you can also minimize all open windows by pressing the key combination Windows logo key+m.

F 5.1.4 Restoring a Window to Its Previous Size

When a window is minimized or maximized these commands become unavailable on the window’s control menu. They are replaced by the command Restore (shortcut key = r). This command switches between the previous size of the window and its new size.


To restore a window



1. Press alt+spacebar to open the program window’s control menu (or alt+hyphen for the document window’s control menu).



2. Select Restore (shortcut key = r) and press enter.

F 5.2 Scrolling in a Window

Another way to access more information in a window (often the only way to access it all) is to scroll through the document. When you scroll through a document, the page or surface of the document appears to move behind the frame of the window, revealing new parts of the document to the eye or to a screenreader. To return to the analogy of the Braille page, this is equivalent to moving the document beneath the A4 card to access more of the information.

In Windows 95, any window that contains more information than is displayed in its frame provides scroll bars. These are special areas on the right-hand and bottom edge of the frame that allow you to move through information in the document. Scroll bars have a button control at each end represented by an arrowhead icon. Clicking on these buttons with the mouse moves the document either horizontally or vertically in the direction of the arrow. The scroll bars allow you to move through the document without changing the position of the insertion point. That is, you can move to an entirely new section of the document without losing your original place.

You can also use the keyboard to scroll through a window. The keys that allow this are called the cursor keys. These are as follows:

The arrow keys

These keys move the insertion point in the direction of the arrow. In text files, press alt in combination with the right or left arrow keys to move the insertion point one word to the right or left. Press ctrl in combination with the up or down arrow keys to move the insertion point one paragraph up or down.

The page up and page dn keys

These keys scroll the text one page up or one page down. When scrolling down, the last line of text on the previous screen becomes the first line of text on the following screen. Press ctrl in combination with the page up or page dn keys to move the insertion point to the top or bottom of the current page of text without scrolling.

The home and end keys

These keys move the insertion point to the beginning or end of a line of text. When used in combination with the ctrl key, they move the insertion point to the beginning or end of the current document.

The shift key

Each of the keys described earlier, when used in combination with the shift key, selects a given amount of text, depending upon the operation of the keys.

G Dialog Boxes

A dialog box is a special kind of window that Windows-based programs use to collect information from the user. Many commands in Windows require complex choices to be made by the user before the command can be carried out. The dialog box standardizes and simplifies this process.

Dialog boxes are simple windows without menu bars or control menus. Typically, they appear on the screen when you select a command and remain on the screen until you have performed some action or actions. Because dialog boxes have several specialized features and controls, they may initially be confusing to the visually-impaired user. Once you master a few simple concepts, however, you will find that virtually all dialog boxes are the same.

The following sections discuss the types of dialog boxes, the process of navigating in a dialog box, and the various elements that you will find there.

G 1 The Types of Dialog Boxes

Dialog boxes consist of two main types, determined by how they control the system focus.

G 1.1 Modal Dialog Boxes

The most common type, a modal dialog box, requires you to take an action that closes the dialog box before you can continue working in your program. For example, in the Print dialog box in Microsoft Word, you must either carry out the Print command or cancel it before you can continue working.

Modal dialog boxes have a set of obligatory command buttons on the bottom or left edge of the window, requiring the user to make a choice that either carries out the relevant command or cancels it. Most commonly, these buttons are marked OK and Cancel.

G 1.2 Modeless Dialog Boxes

The other, less common, type of dialog box is called modeless. This type of dialog box allows you to work in your program while the dialog box remains open. It is used whenever an option or command is applied multiple times in the same way. For example, the Spelling or Replace dialog boxes in Microsoft Word allow you to continue working in the document in a limited way while the dialog box is open. You shift back and forth between the dialog box and the document using a command like ctrl+tab. See Section G 2.2 for more about navigating in such a dialog box.

Modeless dialog boxes can be identified by the absence of an OK button. Typically, the user carries out the command and the dialog box stays open until the user selects the Close or Cancel button..

G 1.3 Message Boxes

The message or warning box is a specialized, simple modal dialog box that requires no user input beyond the action that closes the box. Typically, a message box pops up on the center of the screen in response to an event or problem that occurs when a command or function is carried out. The box contains the text of the message or warning, and a single OK button which you must activate to continue working. Other types of message boxes, such as those associated with Printer errors, give you additional options, such as Retry or Cancel.

G 1.4 Properties Dialog Boxes

Many items in Windows 95 have a special dialog box associated with them called a properties dialog box (also called a property sheet). A properties dialog box allows you to change settings and enter information for the associated object. For example, the Taskbar Properties dialog box contains options for displaying the taskbar on the screen and for changing the Start menu programs. When an object has the system focus, you can access its properties dialog box with the shortcut alt+enter. Or, you can open the object’s context menu (shift+f10) and select the Properties command (shortcut key = R). See Section D 2.4 for more about the context menu.

G 2 Working with Dialog Boxes

There are four levels of navigation in dialog boxes:



1. Activating a dialog box



2. Moving from item to item within the box.



3. Moving from tabbed page to tabbed page within the box.



4. Carrying out the contents of the box with the command buttons.

The following sections discuss each of these four levels.

G 2.1 Activating a Dialog Box

As is true for all windows, a dialog box must have the system focus before you can work in it. In most cases, this is not a problem, since most dialog boxes can’t be on the screen without having the system focus. However, some dialog boxes allow you to shift back and forth between a document window and the dialog box (see Section G 1.2 on modeless dialog boxes). The command ctrl+tab allows you to switch back and forth between such a dialog box and the document where you are working. As with all windows, when a dialog box becomes active its title bar changes color (blue, in the default color scheme).

G 2.2 Navigating Inside a Dialog Box

There are two ways of navigating inside an open dialog box: the tab key and shortcut keys.

G 2.2.1 The tab Key

The tab key allows you to move the focus to each element of a dialog box in turn. An element in a dialog box must have the system focus before you can make changes to it. (see Section G 3 for information about working with dialog box elements).

When you open a dialog box, the first element has the system focus—generally the element closest to the upper left-hand corner of the box. The tab key moves the focus to each element of the box in turn, following a general up-to-down and left-to-right progression. To reverse the direction of this movement, use the key combination shift+tab. When the focus has moved through all of the elements in the dialog box, it moves to the first element and begins again. If the dialog box is one that has tab section dividers, the selection will cycle through all of the elements on the current tabbed page. See Section G 2.3 for more about tabbed pages.

NOTE

The enter key usually has a special function in dialog boxes and should be used with care. Generally, it activates the default command button (typically OK) for the dialog box as a whole. Therefore it usually can’t be used in making changes to individual elements within the box.

G 2.2.2 Shortcut Keys

The other way to navigate inside a dialog box is with shortcut keys, which allow you to swiftly carry out common commands and functions. As with the menu bar, the shortcut keys in a dialog box are accessed with the alt key in combination with a key for another character. This shortcut character is the one that is underlined in the option’s label.

In order to use shortcut keys in a dialog box, the dialog box must be the active window. The shortcut key combinations only work for the currently selected section tab (see Section G 2.3). Because there are many different items in a dialog box, shortcut keys have different effects depending upon the type of item. In some cases, the shortcut key alone changes the setting. In other cases, it shifts the system focus to that item and the user is then required to perform a further action, such as selecting items from a list. See Section G 3 for more about dialog box elements.

G 2.3 Working with Tabbed Pages

Some of the larger and more complex dialog boxes in Windows 95 have a major new feature: tabbed pages. In these dialog boxes, related items are grouped together onto a separate page-like screen element called a tabbed page. A group of these tabbed pages is represented in the dialog box window as a stack of pages, each with a staggered projection or tab protruding from the top and bearing the title of the page, much like the label tabs on file folders. (Note that tabbed pages are sometimes referred to simply as tabs. We call them tabbed pages here to avoid confusion with the tab key.)

Only one tabbed page in a dialog box may be active at a time. The active page is topmost in the stack, and its upper tab label is in bold type. While a given tabbed page is active, the shortcut keys and the tab key only navigate within that page. To make changes to elements in other tabbed pages, the current page must be changed. There are two ways to do this using the keyboard.

The key combination ctrl+tab, when used inside an active dialog box with tabbed pages, brings the next page in the stack to the front. (Note that this is the same command that is used to shift the system focus between the dialog box and the document window in modeless dialog boxes, discussed in Section G 1.2).

Another way to move between tabbed pages in a dialog box is to use the arrow keys. To do this, the system focus must be on the current page’s tab. That is, the tabbed page’s title must be selected. This is visually indicated by the presence of a dotted line around the title. In general, a page’s tab is the first element selected when that page becomes active. So one way to navigate quickly in a dialog box full of tabbed pages is to use the key combination ctrl+tab to switch to the next page and move the selection to that page’s tab, and then use the arrow keys to navigate through the stack. In stacks with many pages, this saves time, since the tabs are arranged in rows and columns and you can use the up or down arrow keys to navigate more efficiently.

NOTE

As you move through a stack of tabbed pages, the organization of the tabs on the screen appears to shift or rotate, as pages move forward to the top of the stack.

G 2.4 Exiting a Dialog Box

To exit a dialog box and accept the changes you have made, select the button labeled OK. In most cases, this button is activated by default if you press enter. In some cases, particularly in certain message windows, the default option is the Cancel button. The default button is indicated visually by a bold line drawn around the outside of the button.

To exit a dialog box without accepting any changes, select Cancel, or simply press esc. This closes the dialog box and returns you to the active program.

G 3 Elements of a Dialog Box

Dialog boxes contain some or all of the following elements.

G 3.1 Command Buttons

All dialog boxes have command buttons, which implement the changes made to the dialog box as a whole. Command buttons appear as raised rectangles, with a pushed-in look when you activate them. They are usually located in a row column on the bottom or left edge of the box. One of these buttons is the default command button—that is, the button that is activated if you press enter from most places in the dialog box (see Section G 3.12 for more about the default button).

G 3.1.1 Kinds of Command Buttons

Most dialog boxes have an OK button, which closes the dialog box and carries out the dialog box settings, applying any changes you have made. Some dialog boxes include command buttons with the name of the command, such as Save. The Cancel button allows you to cancel any command by closing the dialog box without saving any changes you have made to the current settings. The shortcut for the Cancel button is the esc key.

Certain types of dialog boxes, especially the modeless variety (See Section G 1.2), contain neither the OK nor the Cancel button. In the Find and Spell dialog boxes, for instance, the user is presented with options related to a repetitive command—Find, or Find Again—and a button labeled Close, which simply closes the dialog box without carrying out any further commands.

Some dialog boxes have a Help button, which brings up the Help information box for the dialog box. There is also an Apply button, which carries out changes you have made but does not close the dialog box. This allows you to check the results of an action (such as a formatting change) without closing the dialog box. Then, if you are not satisfied with the settings, you can change them and select Apply again.

G 3.1.2 Working with Command Buttons

There are three ways to operate command buttons through the keyboard. The first is to use the tab key to move the system focus to the button, then press enter or the spacebar to activate it.

Most command buttons also have shortcut keys, which both select and activate the button in a single step. Pressing esc, for instance, immediately closes and cancels the dialog box from anywhere in the box.

Third, most dialog boxes have a default command button, indicated by the heavier black line around its border. Usually, this default button is the OK button, and you can activate it by pressing enter from anywhere in the dialog box, with the following exceptions:



1. If the system focus is already on another command button, pressing enter activates that button, rather than the default.



2. The enter key will not activate the default button if the system focus is on a folder or drive list box and a folder or drive in the list is selected. Pressing enter in this case changes the selected folder or drive.



3. Sometimes the OK button is unavailable (displayed in a lighter gray type). This means that you must perform some action before you can carry out the command. For instance, if you are in the Open dialog box on the File menu and you have no file selected, there is no action for the program to perform. You must open a file or cancel the dialog box.

G 3.2 Check Boxes

Check boxes are simple controls used to switch options on and off. They are represented on the screen by a small square to the left of an option label. The square is empty when the option is off. When the option is switched on, a check mark appears in the square. The keyboard section of the Accessibility Options dialog box, for instance, has check boxes for the options StickyKeys, FilterKeys, and ToggleKeys. (See Section I for more information about Accessibility options.)

G 3.2.1 Working with Check Boxes

Many check boxes are assigned access keys, indicated by the underlined character in the item’s name. Access keys work directly on check boxes, allowing you to simultaneously select the option and change its state. You can also use the tab key to move the system focus to the check box and press the spacebar to switch the option on or off. Because the check box is a toggle switch, you can simply press the spacebar or the access key a second time to restore it to its original state. As with other elements in a dialog box, your changes will not register until you carry out the command using the command buttons.

G 3.3 Option Buttons

Option buttons (also called Radio Buttons) display a group of mutually exclusive options in a vertical column, all relating to a particular setting or parameter. On the screen, option buttons are represented by small circles. Like the push buttons on a radio, only one of these options can be selected at a time, but one must always be selected. The selected option is indicated by a dot in the center of the respective circle.

For example, the Page Range section in the Print dialog box in Microsoft Word gives the user three options: All, Selection, or Page Range. One of these options must be selected before you can print the document.

G 3.3.1 Working with Option Buttons

There are two ways to access option buttons from the keyboard. The first is to use access keys, which are usually assigned to the specific options in the option group. In the previous example, for instance, each of the three options has its own access key. Pressing the access key for Page Range moves the selection from the default option (All) to the Page Range option. The second method is to move the system focus to the option group using the tab key, and then press the up or down arrow keys to shift the selected button within the group. After you have changed the selected option, you can use the tab key to move away from the group.

G 3.4 Text Boxes

Text boxes (also called edit controls) are simply boxes where you are required to enter text to specify a file name or path or a string of text to be used in a command. In a dialog box, the text box usually can contain from one to 50 characters.

G 3.4.1 Working with Text Boxes

You can move the system focus to text boxes with the tab key or with access keys. In either case, the system focus moves to the box and an insertion point appears somewhere in the box, ready for you to enter text. This insertion point appears as a single vertical bar. Use standard Windows word-processing key commands to move the insertion point within the text you are typing (the arrow keys, home, and end). You can also use ctrl+x, ctrl+c, and ctrl+v as usual for cutting, copying, and pasting.

When you move an empty text box to the insertion point for your keyboard, input appears at the left side of the box and you can begin typing. In many cases, however, a text box already contains text. This text may be the current data for the option or a default entry (the current file name, for instance). In this case, heed the following caution.

CAUTION

If you wish to edit or add to the existing text without deleting or overwriting it, you must first remove the highlight by pressing the right or left arrow keys or the home or end keys.

If you accidentally delete text in a text box, it is usually possible to recover it by canceling the dialog box and opening it again.

G. 3.5 List Boxes

A list box displays a list of items for you to choose from. Examples of list boxes include: file lists, lists of drives, and lists of fonts. In some dialog boxes, there is not enough room to display all the list options on the screen at one time. Thus, the list box is condensed into a small box containing the current selection, with a downward-pointing arrow to the right of the box indicating further options. Like a drop-down menu, a list of other options appears to drop down below the current option when a list box is opened.

G 3.5.1 Working with List Boxes

In most list boxes, called single selection list boxes, only one item can be selected at a time. Use the following procedure to work in such a list box.

To modify a single selection list box



1. Move the system focus to the list box using the tab key or the item’s access key.



2. Navigate in the list, using the up or down arrow keys.

In especially long lists, you can type the first letter of the option you want and jump to items beginning with that letter.



3. Once you have selected an item, press tab to move away from the list box and continue working in the dialog box.

CAUTION

In most list boxes, you do not need to press enter to make a selection. As elsewhere in the dialog box, pressing enter usually activates the default command button, closing the dialog box and implementing your changes. However, when you are in a list box for drives or folders, you are required to press enter to change the selection. If you wish to change the current drive or folder in such a list box, use the arrow keys to navigate in the list, and then press enter to carry out the change.

There are two kinds of list boxes that allow for multiple selections. The following sections describe how to work with these varieties.

G 3.5.2 Working with Extended or Multiple Selection List Boxes

Some list boxes, called extended selection list boxes, allow you to choose more than one adjacent item in a list. An example of such a list is in the File Open dialog box of Microsoft Windows, where you can select a block of files you wish to open in the same folder. Others types of list boxes, called multiple selection list boxes, also allow you to select multiple items on a list even if the items are not adjacent. This is true of the file lists in Windows Explorer or My Computer. To navigate in such list boxes, use the following procedure:

To modify an extended or multiple selection list box



1. Move the system focus to the list box using the tab key or the item’s access key.



2. Navigate in the list using the up or down arrow keys.

In especially long lists, you can type the first letter of the option you want and jump to items beginning with that letter.



3. To extend your selection over a number of items in the list, hold the shift key down while using the navigation keys (the arrow keys, end, or home).



4. If the list box allows for multiple selection, press the ctrl key to move through the list while keeping previous items selected.



5. Press the spacebar to select other, non-contiguous items.

To remove an extended or multiple selection, press one of the navigation keys without holding down the shift or ctrl key.

G 3.6 Combo Boxes

A combo box is a combination of a text box and a list box. Combo boxes are often used when you are required to type in a file name: you can either type the file name directly into the text box, or you can open the list box and browse through the items on the list. When you select the item you want, the name is automatically entered in the text box. An example of a combo box is the address book in Microsoft Exchange, where you can type a name in the text box or scroll through a list of entries to find the name you’re looking for.

G 3.6.1 Working in a Combo Box

The two components of a combo box are related. When you select a combo box using either tab or its access key, the system focus shifts to the text box component. As with other text boxes, this box may contain default text (the current setting, for example). If so, be aware that pressing any key except a navigation key overwrites this text. (see Section G 3.4 for working in text boxes).

Because the elements in a combo box are interrelated, working in one affects the contents of the other. For example, in a combo box that lists the files in a given folder, if you type a wildcard character and an extension in the text box and press enter (*.doc, for instance), you limit the contents of the list box to files that meet those conditions. Also, typing the first letter of the option’s name in the text box usually causes the list box to jump to the items beginning with that letter.

In some combo boxes (such as the example from Address Book, mentioned earlier), the down arrow key shifts the system focus from the text box to the list box. In others, you must use the tab key (shift+tab to return to the text box). Once you are in the list box, you can use the navigation keys as usual to move through the list (see Section G 3.5 on working in list boxes). As you move through the list, each item you select is entered in the text box.

G 3.7 Sliders

Windows 95 uses a kind of control called a slider for choosing a rate or setting on a continuous scale. Sliders are represented as horizontal or vertical bars, with a status element or indicator that represents the current setting. As you move this indicator along the bar, the relevant setting increases or decreases. An example of a slider is the Repeat Rate setting in the Keyboard dialog box of the Control Panel. You can control the repeat rate of a character by moving the indicator toward the left to make it slower or the right to make it faster.

G 3.7.1 Working with Sliders

Working with sliders is easy using the keyboard.

To work with a slider using the keyboard



1. Use the tab key or the slider’s access key to move the system focus to the slider element.



2. Use the arrow keys to move the indicator’s position along the bar.

Some sliders are on fixed point scales, and each press of an arrow key moves the indicator one point along the scale. Other sliders offer a much finer level of differentiation, so you may have to press the arrow key many times before you notice a change. To move the indicator in larger jumps, you can use the other navigation keys: the home and end keys select the highest and lowest settings, and page up and page down select a higher or lower value in discrete jumps on the scale.

G 3.8 Spin Boxes

Windows 95 uses controls called spin boxes (or spin controls) to change some settings. Spin boxes resemble simple text boxes, with the addition of a double arrow icon to the right of the box for mouse users. They are used for any setting that has a limited number of sequential options, such as Month, Hour, or Day of the Week. Clicking on the arrow controls (or using the arrow keys on the keyboard) causes the spin box to cycle through the possible settings for the option in sequential order, up or down.

G 3.8.1 Working with Spin Boxes using the Keyboard

Once a spin box has the system focus, press the up or down arrow key to change the setting. Each press of the key causes the setting to move up or down one sequential step (January to February in the Month box, for example). You can also save time by typing in the setting you want.

Some spin boxes contain multiple items. An example of this is the Time option on the Date/Time dialog box in Control Panel. Here, each component of the Time setting (hour, minute, etc.) can be separately adjusted. To do so, use the tab key to shift from item to item within the box, and use the up or down arrow keys as usual to adjust the settings.

G 3.9 Query Icons

In some dialog boxes there is a small square containing a question mark on the right side of the title bar next to the close box. This is the Query icon. Mouse users can click on this square when a given item is selected to display a short description of what the item does. Keyboard users can get the same result by moving the system focus to the object in question and pressing f1 (shift+f1 for Office 97 applications). This opens a pop-up box containing a definition of the dialog box item.

H Other Windows 95 Features

The following is a brief description of some other features in Windows 95.

H 1 My Computer and Windows Explorer

Windows 95 contains two programs for organizing and working with files on your system: My Computer and Windows Explorer. My Computer is simpler and provides fewer features than Windows Explorer, but it can be useful for viewing and working with small parts of your system at a time. Windows Explorer, on the other hand, is a powerful and useful file management tool. The following sections describe these programs and how to navigate within them using the keyboard.

H 1.1 My Computer

My Computer is a simple program that displays the files and folders in the hard disk of your computer and allows you to work with them in limited ways. My Computer conveniently displays small parts of your system.

H 1.1.2 Starting My Computer

By default, an icon for My Computer appears on the left side of the desktop when you start your computer. You can start My Computer from this icon using the following procedure.

To start My Computer from its shortcut icon on the Desktop



1. Move the system focus to the desktop with the following sequence of keystrokes: ctrl+esc, esc, shift+tab.



2. Shift the focus to the My Computer icon if it is not already there. (The tab or arrow keys will shift from icon to icon or you can type m, which toggles between all items on the desktop beginning with that letter).



3. Press enter.

See Section D 1.4.1 for more about using shortcut icons on the desktop.

If you find yourself using My Computer frequently, you can simplify the procedure described earlier by assigning a shortcut key combination to the My Computer icon. See Section D 1.4.5 for details.

H 1.1.3 Setting the Display in My Computer

My Computer’s display can be set to run in a single window or in multiple windows, depending on how much information you need to have available to you while you are working. When you select a folder and open it, you can choose whether its contents are displayed in a new window, or in the same window replacing the folder list.

To set the view in My Computer



1. Start My Computer.



2. On the menu bar, select View (access key = alt+v).



3. Select Options (access key=o).



4. Press the tab key to move to the Folders tab of the dialog box.



5. Press the tab key and the arrow keys to select the presentation mode you want.



6. Select OK or press enter to accept the changes.

In the View Options menu, you can also change the file display option from the default Large Icon view to the more text-based List view (access key=m).

H 1.2 Windows Explorer

The Windows Explorer program is a more powerful file management tool than My Computer. It resembles the File Manager program in earlier versions of Windows, which it was designed to replace. Like File Manager, Windows Explorer presents information about your system in a split screen, or dual-pane, display. The left pane of the program window shows a tree view of your folder structure (the All Folders display; see Section H 1.3). The right pane displays the contents of the currently selected folder (the Contents display). Unlike My Computer, Windows Explorer can also display the files and folders of any connected servers.

H 1.2.1 Starting Windows Explorer

If you have a keyboard with the Windows Logo key, press the Windows Logo key+e to open Windows Explorer from anywhere in Windows 95.

Otherwise, press ctrl+esc to access the Start menu, and select Programs (access key=p). Move the selection to Windows Explorer (you can also jump to it by pressing w). Press enter to start the program.

H 1.3 About Tree View

Both My Computer and Windows Explorer use Tree View to display the folder structure. Windows 95 uses this special type of display for objects that are organized in a hierarchical relationship. As its name suggests, the display is based on the analogy of a tree, with lower-level objects branching off from higher-level objects. In Tree View, a lower-level folder is always below and indented from its parent folder. This relationship is also indicated by a graphic of a vertical line, or branch, that drops from a higher-level object with horizontal twigs branching off it to each lower-level object the branch contains.

In Tree View, branches can be expanded and collapsed to allow a user to work with different levels of organization. When a branch is collapsed, a plus sign appears to the left of the higher-level object, indicating there is more information than is currently being displayed. When the branch is expanded (by pressing the right arrow key when the branch is selected), this plus sign changes to a minus sign. To collapse the branch again, press the left arrow key.

Other useful key commands in Tree View:

SYMBOL 183 \f "Symbol" \s 11 \h 
To move up one level in the hierarchy, press backspace.

SYMBOL 183 \f "Symbol" \s 11 \h 
To expand everything below the current selection, press asterisk (*) on the numeric keypad.

SYMBOL 183 \f "Symbol" \s 11 \h 
To collapse everything below the current selection, press the minus sign (-) on the numeric keypad.

H 1.4 General Navigation Commands in Explorer and My Computer.


To move the focus in the window

SYMBOL 183 \f "Symbol" \s 11 \h 
Use the tab key or f6 to move from pane to pane (that is, from All Folders to Contents).


To select items in a list (tree view or file view)

SYMBOL 183 \f "Symbol" \s 11 \h 
Use the up or down arrow keys to move the selection through items in a list.

SYMBOL 183 \f "Symbol" \s 11 \h 
Press the initial letter of the item to jump to the items starting with that letter.

SYMBOL 183 \f "Symbol" \s 11 \h 
Use the home and end keys to jump to the first and last item in the list.

SYMBOL 183 \f "Symbol" \s 11 \h 
Press page up or page down to jump to the first or last items on the screen.


To navigate in the folder tree (tree view only)
SYMBOL 183 \f "Symbol" \s 11 \h 
Use the right or left arrow keys to expand or collapse the currently selected branch.

SYMBOL 183 \f "Symbol" \s 11 \h 
Press the asterisk (*) and the minus sign (-) on the numeric keypad to expand or collapse all branches below the current selection.

SYMBOL 183 \f "Symbol" \s 11 \h 
To move up one step in the hierarchy, press backspace.

To select multiple items (file view only)
SYMBOL 183 \f "Symbol" \s 11 \h 
In a file list, use the shift key with the navigation keys to select blocks of items.

SYMBOL 183 \f "Symbol" \s 11 \h 
Press ctrl and the arrow keys to move through the list and press the spacebar to select and clear individual items (see Section G 3.5 on list boxes).


To update the contents of a window (tree view or file view)

SYMBOL 183 \f "Symbol" \s 11 \h 
Press f5 to update (or refresh) a window. This is useful if you know the contents of the window have changed (for instance, if you change a disk in drive A.)


To open files or folders (tree view or file view)

SYMBOL 183 \f "Symbol" \s 11 \h 
Select the item and press enter. On a folder, this opens the folder and displays the new contents. On a file, this opens the file in the program which created it.

H 1.5 File Management Commands in Explorer and My Computer

Generally, file management commands are the same for either program. The following sections describe some of the most common commands.

H 1.5.1 Creating a New File, Folder, or Shortcut

It is easy to create a new file or shortcut in both programs, and easy to create a new folder in Windows Explorer. You cannot create a new folder in My Computer.

To create a new file, folder, or shortcut



1. In the folder tree, select the drive or folder that contains the new object.



2. Press enter to open the folder.



3. Open the File menu (alt+f).



4. Select New (access key=w)



5. Select the type of item you wish to create (file, folder, or shortcut).

The new item appears in the list, with an insertion mark for you to name it. See the caution in the following section regarding file names.

You can also create a shortcut to a file or folder by using the Copy and Paste shortcut commands on the Edit menu (see Section H 1.5.3)

H 1.5.2 Renaming a File or Folder

Windows 95 allows you to name folders and files with names of up to 256 characters, including spaces. This means less memory work for the user, since it allows you to use more descriptive file names. It is easy to rename files and folders using the keyboard.

To rename a file or folder



1. Select the item you wish to rename.



2. Press f2, or open the File menu (alt+f) and choose Rename (access key=m).



3. Type in a new name or use text editing commands to edit the old one (see Section G 3.4 for working in text boxes).



4. Press enter to accept the new name.

CAUTION

16-bit applications (such as Word 6.0) do not recognize or save long file names even when run under Windows 95. In these programs, you are still restricted to the old eight character file name and three character extension. Long file names are converted to an abbreviated form, usually the first six characters of the name followed by a tilde (~) character and a number. For example, the long file name “Letter to Sam” is reduced to “Letter~1.doc.” Another file in the same folder with a similar name, such as “Letter to Jill,” becomes “Letter~2.doc.”

H 1.5.3 Moving and Copying a File or Folder

In both My Computer and Windows Explorer you can use the standard Windows 95 shortcut keys for moving or copying text to move or copy files and folders.

NOTE

For copying and moving files and folders, it is sometimes useful to see the contents of two folders simultaneously. Unlike its predecessor, File Manager, Windows Explorer can only display one dual pane view at a time. To get around this limitation, you can simply open another copy of Explorer.

To copy a file or folder from one location to another



1. Select the item.



2. Press ctrl+c to copy the item (or from the Edit menu, choose Copy).



3. Move the selection to the new location.



4. Use ctrl+v to paste the item (or from the Edit menu, choose Paste).

If you want to paste a shortcut to the item in the new location, rather than a copy of the item itself, you can use the Paste Shortcut option on the Edit menu.

To move a file or folder from one location to another



1. Select the item.



2. Press ctrl+x to cut the item (or from the Edit menu, choose Cut).



3. Move the selection to the new location.



4. Use ctrl+v to paste the item (or from the Edit menu, choose Paste).

CAUTION

Remember that each time you cut or copy an item using ctrl+x or ctrl+c, you replace the current contents of the clipboard. When you use this method to move files, be careful to avoid accidentally deleting a file while it is in the clipboard.

H 1.5.4 Deleting a File or Folder

Use the following method to delete a file or folder using the keyboard.

To delete a file or folder



1. Select the item or items.



2. Press the delete key.

A message box appears, asking if you wish to send the item to the Recycle Bin (see Section H 3).



3. Select y to delete the item, n to cancel.

To delete an item without sending it to the Recycle Bin, select the item and press shift+delete. Remember that the item cannot be restored in this case.

H 1.5.5 Viewing Properties of a File or Folder

As with File Manager, My Computer and Windows Explorer allow you to view file properties such as the size of the file, the date created, and file attributes. Select View (access key=v) from the menu bar of either program to display a drop-down menu of options for changing the type of information displayed or the sort order of the file list.

You can also view the properties of a single file or folder as follows.

To view the properties dialog box of a single file or folder



1. Select the item.



2. Press alt+enter to bring up the Properties dialog box of the object, or choose Properties (access key=r) on the File menu.

H 1.5.6 Undoing a File or Folder Operation

If you make a mistake, you can undo a file or folder operation in either program. The Undo command on the Edit menu allows you to undo up to your last ten actions starting with your most recent one.

To undo a file or folder operation



1. Open the Edit menu (alt+e).



2. Choose Undo (access key=u).

The option is named for the action you are undoing (for example, Undo Move).



3. Choose Undo again to cancel the operation previous to that, and so on.

H 2 Control Panel

The Control Panel program allows you to customize many Windows 95 features. Its contents depend on the hardware and software you have installed in your system. Some standard options in the Control Panel are: Accessibility Options, Date and Time, Display, Fonts, Keyboard, Mouse, Sounds, and Printers. When you activate these options, a dialog box opens. You can navigate in these dialog boxes in the usual way (see Section G for more information on dialog boxes).

To start an option in Control Panel



1. Open the Start menu (ctrl+esc).



2. Select Settings (access key=s), then Control Panel (access key=c).



3. Use the tab key to move between the Drives list box and the contents window of Control Panel.



4. Use the arrow keys to move from option to option in the contents window.



5. When you find the item you want, press enter.

The Control Panel options that are useful for visually impaired users are described in the following sections. The Accessibility Properties dialog box is described in Section I 1.

H 2.1 Mouse Options

The Mouse Options Properties dialog box offers you several controls for changing the settings of your mouse. In the motion section of the box, for example, you can change the speed of the mouse movement and add a trail to the mouse cursor to assist you in tracking its movement on the screen. This may be helpful to users with partially impaired vision.

H 2.2 Multimedia Options

The Multimedia Properties dialog box offers you controls for audio, video, MIDI, CD Music, and Advanced Features. If you are using a SoundBlaster® card, for instance, there is a slider control for adjusting the volume in the Playback option of the Audio section. You can also change your preferred audio device in this area.

H 2.3 Display Options

The Display Properties dialog box allows you to adjust the screen display. There are sections for Background, Screensaver, Appearance, and Settings. In the Appearance section you can change the sizes and colors of text and objects on screen, such as menus, title bars, and scroll bars. This can be very useful for people who have moderately impaired vision.

H 3 The Recycle Bin

The Recycle Bin is a new feature in Windows 95 that provides a margin of safety in deleting files or folders. Essentially, the Recycle Bin is a special folder on your hard disk where copies of your files are stored once they have been deleted. By default, a shortcut to the Recycle Bin appears on the Windows desktop when the program is installed. Deleted items remain in the Recycle Bin until you retrieve them, or until you intentionally empty the Recycle Bin. Note that if you delete an item with the key combination shift+delete, the item is not saved in the Recycle Bin and is therefore permanently deleted.

CAUTION

Files or folders deleted from 16-bit applications (such as Word 6.0) or from a DOS box run in Windows 95 are not saved in the Recycle Bin. They are therefore permanently deleted and cannot be restored from within Windows 95.

H 3.1 Retrieving Files from the Recycle Bin

Use the following procedure to restore items you have deleted by mistake.

To retrieve files from the Recycle Bin using the keyboard



1. Open My Computer or Windows Explorer.



2. Select the Recycle Bin folder in the folders list.



3. Press enter to open it.

A list of deleted files and folders appears.



4. Select the file or files you wish to restore.



5. Open the File menu (alt+f) and select the option Restore (access key=e)

H 3.2 Emptying the Recycle Bin

You should empty the Recycle Bin from time to time to save disk space. To do so, open the File menu (alt+f) in either Windows Explorer or My Computer. Choose the option Empty Recycle Bin (access key=b)

H 4 The Clipboard

The Clipboard is a part of the program memory that Windows 95 reserves for temporary storage of data. When you cut and paste information between different programs or within a program, this data is stored in the Clipboard. In programs like My Computer and Windows Explorer, the Clipboard is also used to copy and move files and folders.

A Cut command (ctrl+x) deletes the selected data from its current location and stores it in the Clipboard. You can then use the Paste command (ctrl+v) to insert this data into a new location. This can be another location in the current file, a new file, or even a file in a different program.

A copy command (ctrl+c) also stores the selected data in the Clipboard, but it makes a copy and does not delete the selected data.

IMPORTANT

The Clipboard can only store one set of data at a time. Each time you use the copy or cut commands from the Edit menu or the keyboard, the previous contents of the Clipboard are deleted and replaced with whatever you are currently cutting or copying. This is true even if no data is selected and you push these keys by mistake. The contents of the Clipboard are also deleted when you exit Windows.

I Accessibility Options

Windows 95 provides several accessibility features for users with limited dexterity, or who have a visual or hearing impairment. These features include a customizable user interface, allowing you to change the size and color of objects on the desktop, create a customized mouse pointer, and select various high contrast displays. There are also several features designed to make the keyboard and mouse easier to use.

I 1 The Accessibility Properties Dialog Box

The controls for these features are in the Accessibility Properties dialog box, which is accessed through the Control Panel (see Section H 2).

To open the Accessibility Properties dialog box



1 Press ctrl+esc to open the Start menu.



2. Choose Settings (access key=s).



3. Select Control Panel (access key=c)



4. Use the arrow keys to move the selection to the Accessibility Options icon (access key=a).



5. Press enter.

The Accessibility Properties dialog box contains five tabbed pages: Keyboard, Sounds, Display, Mouse, and General. Use the standard dialog box controls to switch between pages (ctrl+tab) and to move between elements on a page (tab, or access keys). See Section G for more about working in dialog boxes.

The Accessibility Properties dialog box has three command buttons: OK, Cancel, and Apply. The Apply button allows you to test the effect of an option without closing the dialog box.

I 2 Accessibility Shortcut Key Combinations

Each accessibility option has a key combination assigned to it, which allows you to turn on the function from wherever you are in Windows 95. To use these shortcut keys, however, you must first turn them on.

To make a shortcut key combination available for an accessibility option



1. Open the Accessibility Properties dialog box following the procedure in Section I 1.



2. Use ctrl+tab to switch to the tabbed page for the option.



3. Tab to the Settings command button.



4. Select the check box labeled Use this Shortcut.



5. Make a note of the key combination.

This process must be followed for each option.

Accessibility shortcut keys are usually obscure combinations of keys that are not likely to be accidentally used in a program. With some options (StickyKeys, for example), the shortcut keys bring up a message box informing you that you are about to turn the option on, and prompting you to confirm that you wish to do so. Other options (ToggleKeys, for example) work immediately. The shortcut key combinations are listed in the following sections on individual options.

Shortcut keys also can have a time-out period. After a specified number of idle minutes, the feature turns itself off. This can be useful when users with different accessibility needs are sharing the same computer. You can set this time-out period on the General tab of the Accessibility Properties dialog box.

I 3 The Keyboard Accessibility Tab

The Keyboard tab offers three options that are not only particularly helpful for users who have limited dexterity, but may also assist visually impaired users. There is also an option to enable additional keyboard support in programs. These features are described in the following sections.

I 3.1 StickyKeys

StickyKeys is designed to assist users who cannot hold two keys down simultaneously, and thus have trouble with operations requiring key combinations. With StickyKeys, you can press a control key first (alt, ctrl, or shift), and then the shortcut key required. The key combination to turn on StickyKeys is the shift key, pressed five times.

I 3.2 FilterKeys

With FilterKeys, brief or repeated keystrokes are ignored. This is to help users who have dexterity problems. The key combination to turn on FilterKeys from any program is the right shift key, held down for eight seconds.

I 3.3 ToggleKeys

ToggleKeys allows you to keep track of your keyboard settings by making an audio alert when you press the caps lock, num lock, or scroll lock keys. The shortcut key for turning on ToggleKeys is the num lock key, held down for five seconds.

I 3.4 The Extra Keyboard Help Check Box

The check box labeled Show Extra Keyboard Help tells Windows 95 programs to provide extra support for keyboard interactions. This extra help may vary from program to program, but in some programs it can provide keyboard equivalents for some mouse functions (such as items on a toolbar).

I 4 The Sounds Tab

The Sounds tab offers support for users who are hearing impaired, allowing them to substitute visual displays for any sound or speech output from the computer.

I 5 The Display Tab

The Display tab offers support for partially sighted users, allowing users to change the screen display to a special high-contrast mode. This mode features black text on a white background (or vice versa) and large characters. Users can also choose their own customized display in this section. The shortcut key to switch to a high contrast display in any program is left alt+left shift+print screen.

See Section H 2.3 on the Display option of the Control Panel for more about customizing the display.

C

CAUTION

In current versions of Windows 95, the High Contrast option with large text can result in undesirable consequences, such as menus that run off the screen, making them inaccessible. In this case, try increasing the size of the Desktop Area (on the Settings tab from the Display icon of Control Panel), or switch back to a normal screen to restore the system to its usual appearance.

I 6 The Mouse Tab

The Mouse tab contains many options for changing the movement of the insertion point. It also allows you to turn on the MouseKeys function, which allows you to turn your keyboard into the equivalent of a mouse. This can be useful for accessing Windows elements and functions that are not easily available to the keyboard.

I 6.1 About MouseKeys

When MouseKeys is turned on, control of the mouse pointer is transferred to the numeric keypad of the keyboard. The number keys move the pointer according to the position of the keys on the keypad: 8 is up, 2 is down, 6 is right, and 4 is left. The other numbers control diagonal movements. Number 5 (the center key) becomes a single left mouse click when pressed once and a right mouse click when pressed twice. You can use the insert, del, ctrl, and shift keys to do things like mouse dragging. Windows 95 Help contains more details about MouseKeys and its functions. The shortcut key to turn on MouseKeys from any program is Left alt+Left shift+num lock.

I 7 The General Tab

The General tab provides access to other miscellaneous features. Here you can set the automatic time-out period, after which accessibility options turn themselves off. You can choose to be audibly notified when accessibility options are turned on and off. You can also enable alternative input devices (called SerialKey devices).

J The Windows 95 Help System

Windows 95 features a comprehensive online Help system, which has been designed to replace paper documentation.

J 1 About Help

Help is a hypertext system, meaning a set of text files that are organized hierarchically and connected to one another by means of links. In Help, information can be accessed in several ways: by means of a Contents page or an Index, by following links from topic to topic within a given contents page, or by activating a Find or Search command. Help also contains several Wizards, which are small programs that guide you through common tasks, like installing a printer.

There is a Help system for Windows 95, and each program typically has a Help system of its own. These local Help systems can usually be accessed by pressing f1 or by selecting the Help option on the menu bar of the program.

J 2 Accessing the Windows 95 Help System.

There are three ways to activate the Windows 95 Help System:



1. Select the Help option on the Start menu.



2. Press F1 while in the desktop.



3. Select the Help command button in many dialog boxes.

J 3 About the Windows 95 Help System

The Windows 95 Help system is unusual in that it is a non-standard program. The initial window is a dialog box, and therefore lacks both a menu bar and a control menu. Essentially, the program is a collection of dialog boxes. Most of these contain familiar dialog box elements (see Section G for more about dialog boxes). However, a few new navigation skills are required.

J 3.1 Moving Around in Help

As in standard dialog boxes, the tab key moves the focus from element to element within the current tabbed page. To switch to a different tabbed page, press the tab key to move the selection to the title tab, and use the left and right arrow keys to cycle through the pages. The ctrl+tab command for changing tabbed pages does not always work in Help.

When working with lists of options in Help dialog boxes, use the up and down cursor keys to move up and down through the list. Use the right and left arrow keys to expand or contract an item. When you find the topic you want, press enter to open it.

To close Help, select and activate the Cancel command button, or use the esc key to return to your previous program.

J 3.2 The Opening Help Dialog Box

The Help dialog box offers you three types of Help, each on its own tabbed page:



1. The Contents page



2. The Index



3. The Find feature

J 3.3 The Contents Page

The Contents page contains the following sections:

If You’ve Used Windows Before
This section contains useful information for users of previous versions of Windows.

Introducing Windows
This section contains information on new features of Windows 95, registration, and accessories.

How To
This section contains a topic list of tasks, with step-by-step instructions on how to perform them.

Tips and Tricks
This section contains hints on ways to do things quickly and easily.

Troubleshooting
This section contains lists of problems you might encounter, along with possible solutions. You can also access this section from the troubleshooting entry in the Index.

J 3.4 Annotations in Help

You can make notes or annotations in some Help topic windows. These can be notes to yourself, markers for frequently accessed pages, or other information you want to access easily.

To make an annotation in a Help window



1. Select the Options command button (access key=alt+o)



2. On the Options menu, select Annotate (access key=a).

A text editing window appears.



3. Type in your annotation, using the standard Windows text editing commands.



4. If you want the annotation to be permanent, select Save (access key=alt+s).

You will return to your previous Help topic window.

Your annotation is marked by a picture of a paper clip in front of the heading of the page you annotated. Use the tab key to move between elements and annotation markers in Help windows.

To read an annotation, select its paper clip icon with the tab key and press enter. A new window appears, displaying your annotation. To close the annotation window, press esc. You can edit an annotation while viewing it, but remember to save it again using alt+s.

To delete an annotation, open the annotation window and choose the Delete command button (access key=alt+d).

K Running MS DOS in Windows 95

Running an MS-DOS-based program under Windows 95 is simple and straightforward. This is because Windows 95 makes better use of available memory and disk resources than previous versions of MS-DOS or Windows. Windows 95 also allows you to multitask MS-DOS-based programs, so you can have more than one of them running at a time. You can also copy and paste data between MS-DOS-based programs and any other program supporting those commands.

K 1 A Note About Installation

When you install Windows 95, you will be asked if you wish to install into the current Windows directory. If you want to keep your old versions of Windows and MS-DOS on your system, and you have enough free disk space (at least 100Mb), you can select No for this question and specify a new directory for the installation. This allows you to keep both versions on your system.

If you answer Yes, Windows 95 will install itself into the current Windows directory and your existing versions of MS-DOS and Windows will be overwritten. At this point you will be asked if you wish to save your previous versions of MS-DOS and Windows. This is a good idea, since it allows you to restore your system to its previous state if you need to uninstall Windows 95 for any reason.

K 2 Starting MS DOS from within Windows 95

By default, the MS DOS prompt is one of the options on the Programs folder of the Start Menu.

To start an MS-DOS session in Windows 95



1. Press ctrl+esc to open the Start menu.



2. Select Programs (shortcut=P) and press enter.



3. Select MS-DOS Prompt and press enter.

K 3 Working with the MS DOS Window

By default, the MS DOS prompt opens in a window. Like other program windows, the MS-DOS window has a title bar, a control menu, and a frame. It can be resized, stacked, and minimized to a button on the taskbar (see Section D 2). The same three methods for switching between program windows can be used for switching to MS-DOS windows (see Section F 4.2)

Unlike program windows, however, the MS-DOS window lacks a menu bar. Instead, a few general commands, such as Editing and those for setting the properties of a program, are included in the window’s control menu (see Section E 3). Another feature that is unique to the MS-DOS window is the ability to toggle between windowed and full screen modes. See Section F 5.1.1 for more about the Full Screen mode.

K 3.1 The Control Menu of the MS-DOS Window

You can use the usual command alt+ spacebar to access the MS-DOS window’s control menu. This menu contains the usual options for changing the size and position of the window. In addition, it contains two commands that are specific to the MS-DOS window. These commands are: Edit (shortcut=E) and Properties (shortcut=P). These two options are described in detail in the following sections.

K 3.1.1 The Edit Option on the MS-DOS Control Menu

The Edit menu offers options for Marking (shortcut=K), Copying (shortcut=Y), and Pasting text (shortcut=P).

The Mark command changes the shape of the insertion point and allows you to select a block of text to be copied. You can move the insertion point using the arrow keys and extend the selection by pressing shift and any of the cursor navigation keys.

The Copy command copies the selected text to the clipboard, from which it can be pasted into any other active MS-DOS session or Windows program. Remember that the clipboard can hold only one piece of data at a time.

The Paste command pastes the contents of the clipboard into the current MS-DOS session at the insertion point.

Note that the usual Windows shortcut keys for cutting, copying, and pasting text do not work in an MS-DOS Window.

K 3.1.2 The Properties Option on the MS-DOS Control Menu

Choosing this option brings up the MS-DOS Properties dialog box, which allows you to change a number of advanced settings for the current MS-DOS window and any MS-DOS-based program you are running in it. You can specify how Windows 95 allocates memory for that particular program, the size of the default MS-DOS window, the size and color of the screen fonts, and other properties affecting program operation. (see Section G 1.4 for more about Properties Dialog Boxes.)

K 3.2 The Full Screen Option

In Windows 95, you can also switch an MS-DOS window to Full-screen mode. In this mode, the frame, title bar, and control menu of the window disappear, and the screen becomes identical to the familiar black window of the MS-DOS shell. While working in this mode, you cannot access the control menu, so the editing and properties commands become temporarily unavailable. To access these commands, you must switch back to window mode.

The key combination alt +enter toggles back and forth between the window mode and the full-screen mode in an MS-DOS session. Note that this is the same key combination that is used to access an object’s properties dialog box elsewhere in Windows 95.

K 4 Running Several MS-DOS-based Programs at Once

You can run multiple MS-DOS-based programs or multiple copies of the same program simply by opening up more MS-DOS prompt windows. Each session can be individually customized with the Properties Dialog box for that session, as described in K 3.12 earlier.

K 5 Ending a Session

To close an MS-DOS prompt window, type Exit on the command line, or press alt+spacebar to open the window’s control menu and select the option Close.

If an MS-DOS-based program is running, you should shut it down using the recommended procedure for closing that program (press the F7 key to exit Word Perfect, for example) before trying to close the window or exit Windows 95. If you don’t, a message box will appear indicating that Windows 95 cannot close the MS-DOS-based program automatically, and that you must close the program yourself using the appropriate Quit or Exit command. This is to ensure that data is saved correctly.

K 6 Getting Help on Running MS-DOS-based Programs in Windows 95

If you have trouble installing or running your MS-DOS-based programs, open the Windows 95 Help system and look in the Index under MS-DOS Programs. The Troubleshooting section of this topic lists many common problems and their solutions

K 7 Running MS-DOS from Outside Windows 95

You may want to run MS-DOS alone without running Windows 95. There are several ways to do this.

K 7.1 Restarting the Computer in MS-DOS Mode

The Shut Down option of the Start Menu contains an option called Restart the Computer in MS-DOS Mode. Choose this option to reboot and start MS-DOS alone without the Windows 95 graphical user interface.

K 7.2 Booting Directly to MS-DOS

You can also boot directly to MS-DOS when you turn on your computer. To do this, use the following procedure:

To boot directly to MS-DOS during Start-up



1. Turn the computer on or press the Restart button.

The computer checks the disk drives and beep.



2. Immediately after the beep, press alt+F5.

The booting process is interrupted and the computer loads MS-DOS alone without the Windows 95 user interface.



3. To start the graphical user interface for Windows 95 at any time, type WIN at the command prompt.

The version of MS-DOS you boot to is version 7.0 You can also boot directly to a previous version of MS-DOS by following the procedure described earlier, then pressing F4 instead of alt+F5 after the beep. This option is only available if your system meets the following conditions:



1. You chose to save your previous version of MS-DOS during installation (see Section K 1).



2. The previous version you saved is version 5.0 or higher.



3. You have dual boot enabled.

L A Brief Note on Windows NT, Version 4.0

With the release of version 4.0, Windows NT now has a user interface that is nearly identical with that of Windows 95. The few important exceptions to this follow.

L 1 Changes to Startup Procedure

On starting Windows NT, the first thing you see is the Begin Logon dialog box, with the message Press ctrl+alt+del to logon. (Note that some accessibility utilities may or may not work at this point.)

Press ctrl+alt+del to open the Logon Information Dialog box, which requests the following information:

SYMBOL 183 \f "Symbol" \s 11 \h 
User name:

SYMBOL 183 \f "Symbol" \s 11 \h 
Password:

SYMBOL 183 \f "Symbol" \s 11 \h 
Domain (if you are networked):

After you enter this information and press enter, the familiar desktop appears.

If your screenreader or other accessibility utilities do not work until the program starts, use the following procedure.

To start Windows NT



1. Turn on the computer.



2. Wait until the chirping stops. (This may take several minutes.)



3. Press ctrl+alt+del.



4. Type your user name.



5. Press tab once to move to the next element of the dialog box.



6. Type your password.



7. If you are networked, press the tab key again and type your domain name.



8. Press ENTER.

L 2 The NT Security Dialog

Some useful functions of Windows NT can be accessed via the NT Security dialog box. This dialog box can be opened at any time with the key combination ctrl+alt+delete. When you open this dialog box, you see the following options:

Lock Workstation (Access keys=Alt+W)

Prevents anyone else from using your computer or reading your files without your password. To unlock your computer, follow the startup procedure described earlier.

Logoff (Access keys=Alt+L)

This command first brings up a dialog box confirming that you really intend to end your session, then closes all currently running programs and returns the system to the Begin Logon dialog box.

Shutdown (Access keys=alt+S)

Allows user to choose from a variety of shutdown options, including Shutdown, or Shutdown and Restart in a different mode.

Change Password (Access keys= alt +C)

Allows a user to change his or her account password (in Windows 95, this function is found under the Password icon in the Control Panel).

Task Manager (Access keys=ALT+T)

This opens a very useful program that has many features. Among these are the Applications tab, which presents a list of currently running programs and system information about each one. You can switch to a program on the list or end a task that is not performing properly or is hung. Another feature of Task Manager is the Performance tab, which allows you to monitor your system’s memory, disk performance, and other events.

L 3 The Programs Folder of the Windows NT Start Menu

Because Windows NT can be configured individually for many different users, the Programs Folder of the NT Start Menu is specially organized. When you open it, you see that your programs are divided into two groups of programs: those which can be used by the current user only (private programs), and those which can be used by anyone with an account on the machine (common programs). In some cases, such as the Startup group of programs, there may be a duplicate entry in each group.

M Glossary

Active Window
The window on the screen with the current system focus; the window that accepts keyboard input.

Application
A program you can run. The terms program and application are used interchangeably.
Button
 A type of control that can be clicked with the mouse or other pointing device to initiate an immediate action. See Toolbar button, Command button.
Cascaded Windows
 A way of arranging the open windows on the screen into a fanned stack arrangement, like a hand of playing cards. You can see the top portion of each window and the whole of the front or active window. Compare with Tiled Windows.
Cascading Menu
A further sub-menu opened from an item on a pull-down menu. Indicated on the pull-down menu by a right-pointing arrow. Use the right arrow key or ENTER to activate, and left arrow key or esc to close, returning to the parent option.
Check box
 A dialog box control that is used for options that have two possible states: on or off (checked or cleared). Check boxes look like squares and have a check mark in them when checked and are empty when cleared. Activated with the spacebar or a shortcut key.

Clipboard
The storage place in memory for one piece of data at a time, whether one character, a whole document, or a graphic; used to transfer data within or between documents or programs with the Cut, Copy and Paste commands.

Combo box
In a dialog box, a text box that has a list box or list boxes connected with it. The user has the option of entering the text directly in the text box, or choosing the item from the list box. See also text box, list box, dialog box.
Command Button
Button in a dialog box to initiate an immediate action related to the command as a whole. Also called command button. Operated with the spacebar or ENTER when it has the focus, or its shortcut key.
Context Menu
A small pop-up menu that appears next to a screen object and contains menu items specific to that object. Sometimes called a properties menu, shortcut menu, or right-click menu. Accessed by shift+F10 when the focus is on the object.

Control Menu
A pull-down menu containing commands used to manipulate the size of a window and its position on the screen. Accessed with alt +spacebar for a program window or alt+hyphen for a document window or from the menu bar of a program window.
Cursor
A symbol that represents the point of current system focus on the screen. The cursor may change shape depending upon the type of data, the current task, or its position in a window. In Windows 95, there are usually two cursors always present on the screen: a keyboard (insertion point) cursor and a mouse cursor.
Desktop
The working area of the system, which is also the entire area of your screen. When everything else is closed, it is the part of the system that remains visible. In the organization of files on your hard disk there is also a folder called The Desktop, which contains shortcuts to programs and files that have been placed there for easy access.
Desktop Metaphor
One of the two central visual analogies of the Windows 95 user interface. The screen is like the user’s desk, and it can hold different pieces of work that can overlap each other and still be accessible. See Windows.

Dialog Box
A type of window that opens temporarily and requires the user to enter information that the program needs to carry out a particular command or operation. Dialog boxes have no menu bar and only a limited control menu. They contain various data entry elements and a set of command buttons used for executing commands.
Direct Manipulation
The use of a pointing device to handle objects themselves on the screen by clicking and double clicking with the pointing device. For example: to open a file, double click on the file icon; to move a file from one folder to another, drag and drop the file icon.
Document Icon
 An icon representing a document window that is still accessible, but which has been minimized. Sits in the program window it belongs to. See Icon, Minimized.
Document Window
 A window used by a program to display a file or document that is currently being accessed. Some programs can have more than one document window open at a time. Document windows are always inside the program window of their parent program and have a control menu but no menu bar.
Drag and Drop
The use of a pointing device to carry out tasks directly. For example, by dragging a file icon into the Print Manager icon to print the file.

Drop-Down List Box
In a dialog box, a condensed list box that displays only a small box showing the current selection. A downward pointing arrow next to the current selection indicates the presence of more options that can be accessed by pressing alt+the down arrow key.

Drop-Down Menu
A vertical list of options relating to an item on a menu bar that appears to drop down when the item is selected and activated.
File Icon
A small graphic that represents individual files or programs such as Windows Explorer or My Computer. Has a text name and a graphic to identify which program created the file.
Folder
A subdivision of a disk in which you can store files or other folders. Replaces the term directory in earlier versions of Windows. Folders within folders are called nested folders.

Frame
The border around a window that defines its edges.
GUI / Graphical User Interface
The type of screen display used by Windows 95 in which information is drawn on the screen in the form of graphic images.
I-Beam
The shape of the mouse cursor when it is over a text box (as distinct from the usual upwards pointing arrow of the mouse cursor).
Icon
A small picture that represents some task, operation, file, or program.
Inactive Window
The window or windows on the screen which currently do not have the system focus and do not accept keyboard input. Inactive windows have white title bars by default.

Insertion Point
The form a cursor takes when it is in a text box or other location where text is to be inserted. Either a flashing vertical bar or a small black rectangle.
List Box
In a dialog box, a list of related items for the user to choose from, grouped under a particular heading and surrounded by a thin border.
Main Menu
See Menu Bar.
Maximize
To enlarge a program window to fill the entire screen, or to enlarge a document window to fill the entire program window it belongs to. An option on the control menu of the window. For mouse users, a Maximize button is located on the right side of the title bar, between the close and minimize buttons. See Minimize.
Menu
A list of available commands in a program window.
Menu Bar
A horizontal list of options for controlling a program. Found just below the title bar of the program window. Accessed with alt+ arrow keys, or alt+ shortcut key for a particular option.
Message Box
A simple kind of window that appears temporarily on top of a program window to give the user a message or brief information regarding the current command or operation. Usually the message box remains on the screen until the user takes some kind of action, either Canceling or choosing OK, depending on the message.

Minimize
To shrink a program window to its button on the Taskbar, or to shrink a document window to an icon in the workspace of the program window it belongs to. Keeps the program or file open and out of the way, but not active. The Minimize button appears as a button on the right side of the title bar to the left of the close and maximize buttons. See Maximize.
Modal Dialog Box
A dialog box which must be closed before you can continue working in the program. Compare with Modeless Dialog Box.

Modeless Dialog Box
A dialog box which lets you continue working in the program while it is open. Compare with Modal Dialog Box.

MS-DOS Prompt
A program that allows you to work in an MS-DOS shell without actually exiting from Windows 95. Can be run in either the window or full-screen mode.
Nested Folder
Equivalent to a sub-folder (previously called a sub-directory).
Object Linking and Embedding (OLE)
A feature of Windows 95 that allows documents to contain information created in the same or different programs. The linked or embedded information can be an audio file or graphic, textual, or numerical data.
OLE
See Object Linking and Embedding.
Option Buttons
In a dialog box, a mutually exclusive group of options relating to one parameter. Also called radio buttons (a metaphor based on pop-out buttons of old-fashioned radios). Appear as empty circles when not selected or with a black dot inside if they are selected.
Pixel
The smallest graphical unit in a graphical user interface. A colored dot on the screen. There are 480 by 640 pixels on a standard VGA screen.

Pop-Up Menu
A menu which appears on the screen near the object it is associated with, either to the side (like a Context menu) or above (like the Start menu). Works the same as a pull-down menu.
Program
An application you can run. The terms program and application are used interchangeably.

Program Button
A button on the Taskbar representing a program which is currently running. Displays the program’s title and the name of the open file. Use the arrow keys to move between program buttons along the Taskbar, and spacebar or enter to activate them.
Program Icon
Used in a file list to represent a program which can be started in Windows Explorer or My Computer. Always accompanied by a text name.
Program Window
 A window containing any task or program that is running. Has a menu bar and a control menu.
Properties Dialog Box
A dialog box containing options for a specific object. Shortcut =alt+enter when the object has the focus, or open the object’s Context menu (shift+F10) and choose R for Properties.
Query Icon
In some dialog boxes, provides help that is available regarding specific screen elements. When the focus is on the element you need help on, press F1 (or shift+ F1 in Office97) or open its Context menu with shift+F10 and choose the What’s This? option.
Recycle Bin
A small program that automatically stores deleted files. Files are saved in the Recycle Bin until the user decides to empty the Bin or restore the items to their previous location, or until the bin is full (useful if you change your mind about deleting a file). Items deleted with shift+delete or from 16-bit applications are not saved in the Recycle Bin.

Restore
Returns a window to its previous dimensions after a user has made changes to its size. Restore appears as an option on the control menu of the window or as a button on the right side of the title bar, between the Minimize and Close buttons. Restore replaces the Maximize button when the window is maximized.
Screenreader
Software that interprets what is on the screen, passing it to a speech synthesizer and/or a Braille display, and allows the user to interact with a program.
Scroll bars
Bars that appear down the right or bottom edges of a window to scroll the view of the window contents. Used with the mouse. Scroll bars change the view, but do not move the insertion point.
Scrolling
A process of progressively moving through the screen output of a file, using either key commands or scroll bars.
Shortcut Icons
Small pictures found on the desktop or in the Start Menu that act as pointers or shortcuts to files or programs in the system. Designed to make accessing your files and folders easier and quicker.
Shortcut Key
Specially assigned keyboard commands for quickly accessing menu items or for operating elements in dialog boxes. May or may not be used in combination with the alt key. Indicated by an underlined character in an option’s name.

Slider
In a dialog box, an element used for selecting a setting along a continuum. The position on the scale can be changed using arrow keys or in larger jumps using home, end, page up, and page down.
Spinner
A dialog box element used for adjusting settings. Use the tab key to move between different parts of the setting (the hour, minute, and seconds settings for the time, for example) and up and down cursor keys to change the value, or type in the desired value.

Start Button and Menu
The starting point for accessing programs and files. Opened from any program with ctrl+esc, and navigated using arrow keys or shortcut keys. Found on the Taskbar.
Status Bar
Usually found along the bottom edge of a program window, containing program-specific information such as the current page number, column number, or the status of various controls.

Switch To Command
The easiest way of switching between currently running programs using the keyboard. Accessed by pressing alt+tab. If you continue to hold the alt key down, each press of the tab key will bring the title of the next running program. Release both keys to make a program active.
System Focus
The window, element of a window, or other object that is active at any given time, and which is available to keyboard input. Several levels of system focus exist. For example, program window, document window, element in a document window, or control in a dialog box.
Tabbed Page
A method of organization used in large dialog boxes to divide the elements into groups of related options, each group appearing on its own page. The pages are grouped in a stack, with staggered tabs projecting from the top containing the title names of the pages. Change tabs with ctrl+tab, or use the tab key to move to the current page’s tab and use the arrow keys to move among the tabs for all the pages.
Taskbar
The bar that sits by default along the bottom of the screen, containing the Start button, the clock, and buttons showing the titles of any programs you have running.
Task Cycle Command
A way of switching between running programs. Makes each program active in turn, including open Properties dialog boxes. Carried out by alt+esc.

Text Box
In a dialog box, a box in which text is to be entered. Could be the whole document or restricted number of characters.
Tiled Windows
A method of arranging the open windows neatly on the screen like wall tiles, so that they fill the desktop entirely without overlaps or gaps. Compare with Cascaded Windows.
Title bar
The bar at the very top of every window displaying the name of the window: the program name if a program window, and the name of the open file if a document window. By default, active windows have a blue title bar and inactive windows have a white title bar. Also contains an icon for the control menu, and buttons for minimizing, maximizing or restoring, and closing the window with the mouse.

Toolbar Button
A control for a specific task provided for mouse users in many programs. Usually shortcuts to menu items such as Print. Often toolbar buttons have pop-up textual labels associated with them, called ToolTips, which can be viewed by holding the mouse over the icon. Some screenreaders can access ToolTips.
Unavailable Item
 An item on a menu or in a dialog box that is not available to the user at the current time. Indicated by gray type instead of the usual black.
Warning Box
A window appearing temporarily on top of a program window to warn the user about a particular event. Usually a warning box requires the user to perform an action, such as Closing or Canceling the dialog box, in order to continue working. Also known as an Alert Box.

Window
A rectangular area on the screen that contains the output, controls, and other information related to a particular file, program, or task. There can be many windows open at once in Windows 95.

Window Listing
A list of all accessible document windows (both open and minimized) within one program. Found under the Window menu on the menu bar.
Wizard
A guide that takes you sequentially through common tasks, such as installing a printer. Found in the Windows 95 online Help system.
